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Welcome to the ShockLog® product family. The manual has been 

designed to provide useful information to all levels of users from new 

users to those expert users of the legacy ShockLog products.

The ShockLog User Manual has been written to address the full range  

of ShockLog products. While many of the pictures will include 

references to the ShockLog 298, they are equally applicable to the 

ShockLog 248. Please note that some features are only available on  

the ShockLog 298.

INTRODUCTION

PRODUCT OVERVIEW
ShockLog recorders are small battery-powered data loggers with three built-in piezoelectric accelerometers and an 

internal temperature sensor. The design is optimized for the measurement of shock and vibration for investigative 

and protective purposes of goods in transit and storage throughout the supply chain.    

The ShockLog is suitable for applications where the cost of exposure to out of tolerance impact/environmental 

conditions is high. It is suitable for monitoring fixed or mobile installations and investigating conditions during 

transport, storage or operation.
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SHOCKLOG 298 
The ShockLog 298 combines advanced tri-axial piezoelectric accelerometer technology, the latest electronic 

technology, software and optional connectivity modules into a world class shock and vibration recorder.

The ShockLog 298 monitors shock and vibration based on acceleration or velocity measurements.

The wake up, warning and alarm levels, frequency of data collection, setting of the acceleration or velocity range and 

cut-off frequency of the filter are programmed by the user. When a user defined impact level is exceeded, a visual 

alarm will alert the user and store the data for future analysis.

*Use of lithium batteries is recommended as they provide longer battery life and a wider operating temperature range

FEATURES

• Complete journey profiling • Date & time stamping of events / alarms

• Acceleration or velocity measurements • Data stored in non-volatile memory

• Programmable warning and alarm thresholds • Up to 18 month battery life

• Detailed record of up to 870 impact events • AA size lithium or alkaline battery power

• Built-in internal temperature sensor • Completely self-contained (battery operated)

• Programmable frequency cut-off filters • Tamper-proof factory and user passwords

• Operation, warning and alarm LED indicators • USB & iButton interfaces

OPTIONS

• External temperature / humidity sensor • External temperature/humidity/pressure sensor

• Cellular communication module • Tilt & roll sensor

• Satellite communication module • Zigbee RF communication module

• GPS recording module 
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SHOCKLOG 248 
The ShockLog 248 combines advanced tri-axial piezoelectric accelerometer technology, the latest electronic 

technology and software into an advanced shock and vibration recorder.

The ShockLog 248 monitors shock based on acceleration measurements. The software allows the wake up, alarm 

levels and frequency of data collection to be programmed by the user. When a user defined impact level is exceeded, 

a visual alarm (LED) will alert the user and store the data for future analysis.

FEATURES

• Complete journey profiling • Completely self-contained (battery operated)

• Acceleration measurements • Up to 12-month battery life

• Built-in internal temperature sensor • AA size lithium or alkaline battery power

• Programmable alarm thresholds • Tamper-proof factory and user passwords

• Date & time stamping of events / alarms • USB & iButton interfaces

• Detailed record 1st & 14 most significant events • Operation and alarm LED indicators

• 100G / 250Hz, 30G / 90 Hz or 10G / 40 Hz models 

OPTIONS

• External temperature / humidity sensor

*Use of lithium batteries is recommended as they provide longer battery life and a wider operating temperature range
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A benefit of the ShockLog product line is the availability of accessories 

that enable additional information to be gathered.

SHOCKLOG ACCESSORY KIT 
First time users of a ShockLog recorder are required to purchase an accessory kit in order to receive all of the 

necessary communication cables and software licenses needed to operate the ShockLog.

The ShockLog accessory kit contains the following items:

1 – ShockLog Software (USB drive containing software and user manual)

1 - Quick Start Manual

1 - USB Communication Cable

2 – AA Lithium Batteries

1 - iButton Set (START, STOP, DOWNLOAD, SETUP and CLOCK) 

1 - iButton USB Connection BUS and Cable 

Each ShockLog unit is shipped with batteries, mounting kit and a companion label.  

In the unlikely event that any of the above items are missing when the kit is received, please immediately inform your 

SpotSee Regional Manager or local distributor to arrange for a replacement.

SHOCKLOG CELLULAR COMMUNICATION MODULE
The ShockLog Cellular Communication Module delivers real-time notifications of unacceptable handling in the supply 

chain. Alarm and location summary are transmitted via the global cellular network to the SpotSee Cloud where the 

information is accessible from anywhere in the world.

OVERVIEW OF ACCESSORIES/OPTIONS

SHOCKLOG SATELLITE COMMUNICATION MODULE
The ShockLog Satellite Communication Module delivers real-time notifications of unacceptable handling in the 

supply chain. Alarm and GPS location summary information is transmitted via the GlobalStar satellite network to the 

SpotSee Cloud where the information is accessible from anywhere in the world.
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HPT (HUMIDITY PRESSURE TEMPERATURE) SENSOR
The HPT sensor measures humidity, pressure and temperature. It enables any version of the ShockLog 298 to 

monitor an extended range of environmental factors. The HPT meets the requirements for IP30 and can operate at 

temperatures between -40 and +85°C. An optional extension cable is available for applications where the HPT must 

be mounted remotely from the recorder. A bulkhead adapter is required when using the extension cable.

SHOCKLOG 298 TILT AND ROLL
The Tilt & Roll feature extends the monitoring capabilities of the ShockLog 298 beyond impact and vibration to 

include tilt & roll. Users have the capability to monitor and measure the entire physical environment during a journey 

or storage period. The ShockLog software includes two additional time slot graphs in order to provide a graphical 

representation of the tilt and roll activity recorded. The additional graphs show the Tilt (front to back) and Roll (left 

to right) movement of the unit and are represented as degrees of movement. The data is recorded and displayed in a 

range of ±180°. Reaching 180° indicates full turn over.

SHOCKLOG 298 GPS 
The ShockLog 298 is available with a built-in GPS receiver that records the GPS position of the unit at every summary 

interval and when an event occurs. The receiver / antenna must have line of site visibility to GPS satellites to record 

such information.

Data files with GPS information will be displayed with additional columns in both the summary table and the events 

table. The additional columns include:

• GPS Time and Date • Globe icon (Link to Google Maps)

• GPS Latitude • GPS Velocity

• GPS Longitude • GPS Course (COG)

SHOCKLOG H/T SENSOR
The HT sensor measures humidity and temperature. It enables any version of the ShockLog 298 or 248 to monitor an 

extended range of environmental factors.

SHOCKLOG 298 RF 
The ShockLog 298 is available with a built-in Zigbee RF module. This system allows a user to transmit setup 

information to the ShockLog and receive full data downloads from the ShockLog.  An RF base station connected to a 

PC running the ShockLog software allows for wireless communication between the ShockLog and PC.
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The ShockLog manual applies to ShockLog software version 10.2.4.1 or 

greater and is to be used in conjunction with all ShockLog units (298 

and 248 products). It also applies to most legacy ShockLog ranges 

including the RD298 ShockLog (embedded code version 103 or higher) 

and RD317 Micro ShockLog units (embedded code version 103 or 

higher). While other combinations of the software and embedded code 

versions of a lower number should function in a similar manner, there 

may be some exceptions.

GETTING STARTED

IDENTIFYING SOFTWARE VERSIONS

IDENTIFYING HARDWARE VERSIONS

To determine which version of ShockLog software is installed, 

start the software, look under the “Help” menu option at the 

top of the screen and select “About”. In this case the version is 

10.4.4.1 release date 2017. 

The hardware version of the ShockLog is displayed in the “Communications” dockable window. The communication 

information is only updated when a ShockLog is connected to your PC. In this case, the code version is 21.
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SHOCKLOG SOFTWARE INSTALLATION
To get started with the ShockLog, the first step is to install the software. Please note that many IT systems prevent 

individual users from installing software on their machines or users may have restricted rights. Therefore, it is 

essential that you consult your IT Department to ensure you have sufficient rights to install the software. The 

ShockLog software has been designed to run on a standard PC under Windows 10, 8, 7, XP or Vista. All of these 

operating systems require administration rights to install the software.

Insert the CD into the CD/DVD player on your PC. The set-up process should run automatically. If for any reason the 

set-up program does not automatically run, go to the Start menu and in Run, enter V:\shocklogsetup.exe (where v:\ is 

the CD/DVD driver on the PC) and open the program from there.

Enter your name, company name and the unique serial code 

supplied with the ShockLog CD. The code can be found inside 

the CD software case. The code will begin with “SW.” Once 

the appropriate information and a valid code have been 

entered, click “OK.”

If Microsoft.NET Framework and Microsoft Access are not installed, the following steps will be executed.  A new 

window will appear displaying the Microsoft.net end user license agreement, click “Accept”.

The installation will continue and the system will install components from the CD for the Access Database Engine.  

Click “Install” to continue.
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The Microsoft Access database engine installation wizard will run next. Click “Next” to continue. 

Accept the Microsoft Access End - User License Agreement terms. 

The Access database location is set up next. Click “Install” to continue. 

Click “OK” to complete the setup of the Access Database. 

Microsoft.net framework will install next.

After Microsoft.net Framework and Access have been installed, the installation of the ShockLog software will begin 

automatically. A ShockLog Setup Wizard will install the ShockLog software on your computer. Click “Next” to start  

the installation. 

A new window detailing the end user license agreement required to utilize the software will appear. The user must  

accept the terms of the software by selecting “I accept the terms in the License Agreement”. Click “Next” to continue.
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Next, another ShockLog Setup window will prompt the user for the product options to install. Verify that both 

“Create a shortcut for this program on the desktop” and “Install Software Update Utility” are checked. Click 

“Next” to continue. 

Users can select the location of the software installation. However, it is recommended that the default settings  

be accepted.

To change the directory address, either type over the information in the box or browse for the desired directory 

by selecting the “Change” button. Once you have selected the desired directory, click on the ‘Next’ button.

A window stating “Ready to install the ShockLog” software will appear. Click “Install” to continue.
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The system will begin the installation of the ShockLog software. At this stage a number of progress bar windows will 

appear. A Microsoft software installation warning stating that the software has not been verified for compatibility 

to Windows XP will appear. Click on the “Continue anyway” button. The same window will appear a second time. 

Click on the ‘Continue anyway’ button. When asked to install Maxim and The IMC Group drivers, click “Install”.

Once the system has fully installed, a “Completed the ShockLog Setup Wizard” window will appear. Click “Finish” to 

complete the installation.

The ShockLog software is now loaded and the computer should be back at the Desktop view. In order to create a 

short cut on the Desktop, right click on the Start menu and select the “Explore” option.

The ShockLog programs will have been copied into the following directory: c:\ProgramData\ShockLogSoftware\

ShockLog or it will be installed in the destination directory specified earlier in the setup process. 

Right click on the ShockLog program icon and select “Create Shortcut”. Once the short cut has been created, it can 

be dragged onto the Desktop.

To open the ShockLog software, double click on the shortcut icon from the Desktop.

When first attaching the ShockLog unit to the PC, it will be necessary to install new USB drivers for the PC to 

communicate with the ShockLog.  After connecting the ShockLog to the PC via the USB cable, a “Found New 

Hardware Wizard” window will appear. To the question, “Can Windows connect to Windows Update to search for 

software?” it is essential that the user select “No, not this time” to prevent the system from going to the Microsoft 

website to find the drivers.

Click “Next” and a second “Found New Hardware Wizard” window will appear.  

Select “Install the software automatically (Recommended)” and click “Next”.
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A window with a Microsoft software installation warning stating that the software has not been verified for 

compatibility to Windows XP will appear. Click “Continue anyway”.

The appropriate drivers now will be loaded on the PC and will allow the ShockLog device to communicate with the 

ShockLog Software.

If the drivers do not load correctly, it may be necessary to return to this window and select “Install from a list or 

specific location (Advanced).” Browse the PC to find the appropriate drivers within the ShockLog directory.

If the ShockLog does not connect after successfully loading the drivers, please check the communication ports are 

correct. The port settings are found in the “Tools” menu under Communication Properties. These settings are only 

relevant to legacy ShockLog products.

AUTOMATIC CHECK FOR UPDATES
The ShockLog software has a built-in facility to automatically check the internet for the latest version of software. 

When installing the software, users will be given the option of enabling this feature by the use of a check box. Should 

you wish to change this option after installation, select the “Help” menu. Users are able to turn this on or off with the 

“check for updates” option.

LANGUAGE SUPPORT
The ShockLog software is multilingual. Upon installation, the software will detect the country settings within the 

Windows files and select the appropriate language. Where no translation is available, the system will default  

to English.

If after installation a user wishes to revert back to English settings, it is possible to change the software back to 

English by checking the “English” tick box in the graph and unit options under the Tools menu.

BATTERIES
All ShockLog units operate with AA size batteries. Either 1.5V Alkaline or 3.6V Lithium cells are acceptable. (Do not 

attempt to operate the ShockLog with a mixture of Alkaline and Lithium batteries). The ShockLog 298 unit requires 

two batteries and the ShockLog 248 unit requires one battery.  

Two (2) AA size lithium batteries are supplied with a ShockLog kit. It is highly recommended that lithium batteries 

be used whenever possible as they will provide a greater service life across a wider temperature range. The use of 

alkaline batteries is recommended only on very short journeys or for experiments where the ambient temperature is 

fairly constant and above 10°C/50°F.
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BATTERY TIPS

• Always use lithium batteries for journeys where the temperature may be outside the 10°C to +50°C range.

• The capacity of alkaline batteries drops dramatically when exposed to temperatures below 10°C.

• If using lithium batteries and the ShockLog will be travelling by air, make sure the batteries are approved  

 for air cargo.

• If the batteries are accidentally installed with the wrong polarity, the ShockLog will not be damaged;  

 however, the life of the battery may be severely affected.

NOTE

All ShockLog units are rated to IP67. The battery compartment is isolated from the main body of the 

ShockLog unit and a poor fitting of the battery cover will not dramatically affect the IP rating of the main 

unit. However, if there is water ingress into the battery compartment, the batteries are likely to short and 

cause corrosion of the battery terminals. If this corrosion occurs, the ShockLog will not function correctly, 

and the unit will need to be returned to SpotSee for repair.

INSTALLING THE BATTERIES
The battery compartment is located on the back of the ShockLog unit.  (ShockLog 298 

shown to right). 

Remove the four screws and lift the battery cover clear.

Ensure the orientation of the batteries is correct and insert them into the ShockLog unit. 

Both batteries are oriented in the same direction; the positive terminal for both 

batteries is at the same end of the ShockLog unit. 

Ensure the rubber seal is correctly positioned, replace the battery cover and insert the 4 

screws. Care should be taken when securing the lid. Ensure the screws are tightened evenly 

in a diagonal rotation and tightened to 25cNm torque (hand tight).
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SHOCKLOG MOUNTING RECOMMENDATIONS
Mounting Orientation

The ShockLog axes are indicated on the side of the unit. Mount the ShockLog either vertically or  

horizontally and note the orientation. Variation from the orientation of the ShockLog should be  

noted in order to assist with data analysis at the end of the journey.  

Securing the ShockLog

Whenever possible, it is recommended you mount the ShockLog directly to the product being monitored. Several 

alternatives exist for securing the ShockLog to the shipment: 

• Use all four (4) supplied mounting bolts as shown in Figure A.  

• A mounting plate is available that has been predrilled for the four isolation bushings provided in the mounting kit.   

 A mounting hole in the middle of the plate attaches to the shipment as shown in Figure B. The mounting hole has  

 been sized for an M8 bolt but can be drilled out to accept a larger bolt.

• Magnetic mounts are available and can be secured to the four corners of the ShockLog. 

Mounting Best Practices

Mount the ShockLog as low as possible, but it is more important to be nearest to the most sensitive part of your 

product. Be sure to mount the device to a location that is structurally sound and avoid mounting in the middle of a panel.

When mounting, avoid metal-to-metal contact, and use the rubber bushings provided in the mounting kit to 

decrease excess vibration.

FIGURE A

FIGURE B

Single fixing bolt to Shipment
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Avoid building special brackets to mount the ShockLog. If a cover is required, place the cover over the ShockLog 

but do not attach it to the ShockLog.

When mounting inside packaging or crates, make sure the product is secured by foam or mounting screws to 

ensure the unit records accurate impacts during shipment. If the ShockLog is not attached securely to a shipment, 

the journey data could be compromised as the measurement may be of the ShockLog moving independently of 

the product being monitored

When monitoring a large shipment, always use the anti-vibration bushes. The isolation bushes must fit as shown in 

the Figure A below. For the bushes to work correctly, the ShockLog must not make metal-to-metal contact.

FIGURE A
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The ShockLog user interface has a variety of “dockable” windows that 

allow the user to view information of interest. These windows make it 

easy for users to move around in the journey data files.

OPENING THE SOFTWARE & INITIAL 
LAYOUT SETUP

To get started the software can either be opened by 

double clicking the ShockLog shortcut icon or by selecting 

the ShockLog program from the Start menu. 

When the software first opens you will be presented with 

a “File Viewer” screen in addition to a “dockable” Explorer 

window on the left. Dockable windows in the bottom of 

the screen containing tabs for Communications, Record 

Table, and Events Table will also be presented.

Move each dockable window by clicking the left mouse 

button and holding. Drag the window around and notice 

that small window icons appear at the left, right, top and 

bottom of the screen. As the windows are moved closer 

to one of these icons, it will highlight in green where the 

window will sit.

All of the dockable windows work in any position.  

However, the Explorer window generally works better 

in either of the left/right vertical positions, whereas the 

Record and Event Table windows are better suited to the 

top/bottom horizontal positions. 

It is possible to dock more than one window in the same 

location. If only two windows are to be docked in the 

same location, the windows will be displayed side by side.  

If three windows are to be docked in the same location, 

the software displays an additional icon with a series of 

tabs to move between the windows.
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When the dockable windows are in the desired locations, adjust the size of each window by dragging the border of 

each window. Adjust the window size in order to maximize the available screen area for the File Viewer. 

Windows can be moved and adjusted at any time.

The position of the docked windows can be saved so they are in the same location 

when exiting and entering the ShockLog system. From the Tools menu, select “Save 

Current Settings”. Once this has been done, a confirmation window will appear.

For demonstration purposes, a number of files are included in the database installed 

with the ShockLog software. These files are shown in the Explorer and Record view. 

Click on one of the available files and the Summary Report will be displayed in the File 

Viewer. The demonstration files may be deleted at any time.

With a file open, it is possible to explore the information available from the File Viewer screen. Notice the six tabs 

along the top of the viewer. These tabs link to more detailed information relating to the open file record. The 

information includes: 

• Report 

• Setup

• Slots

• Slot Alarms

• Summaries

• Events
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CREATING A SETUP FILE

SELECT MODEL OR FILE

SETUP WINDOW

To create or modify a setup file, go to the “View” menu at the top of the screen and select 

“Setup.” A new window will appear listing the available ShockLog models. 

The user will select a ShockLog model and create a setup file or open and modify an 

existing file that has been created in the past.

The ShockLog model selected will affect the options available in the setup screens. Certain 

features are only available on certain models. 

To open an existing file, select the ShockLog model of interest and click the “Load File” 

button. A list of available setup files related to the selected model will be shown. Highlight 

the desired file and click on “Open.”

To create a new setup, click “New Setup.”  

The “Current File” button allows you to interrogate a connected ShockLog to determine what setup has been loaded 

into the unit.

When the appropriate ShockLog model has been selected or the desired setup file has been opened, a new window 

will appear. In this example, “Setup – 298” indicates that a ShockLog 298 setup will be created.

The setup window has a series of tabs that guide the user through the available options for the selected ShockLog 

model. The software requires that the user complete the appropriate areas. For a new setup, the system will adopt 

a default setting and complete some sections. The user must step through every window and modify the settings or 

select “Continue.” Guiding the user to step through every window for a new setup ensures that all the options have 

been considered and reduces the chance for a setup error.
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FIRMWARE OPTIONS

STANDARD OPTIONS

FACTORY OPTIONS

The first tab in the Setup screen is  

“Firmware Options.” This section 

defines what factory or peripheral 

accessories are being used with the  

selected ShockLog. If the options 

are grayed out and selected, they 

are default options and cannot be  

changed. If they are grayed out  

without being selected, the options  

are not available for the selected 

ShockLog.

gRMS (Vibration) – Users have the option to record the gRMS values within the time slot graphs, allowing users to 

see the vibration levels throughout a given time slot period. When measuring gRMS, it is required that the 250Hz 

filter be selected. This selection is done automatically by the software. More details on filter settings will follow.

External RH/T – Relates to the ShockLog 298 and 248 with the factory optional Temperature and Humidity  

sensor added.

External RH (RD317 only) – Relates to the Legacy RD317 Micro ShockLog with the factory optional Temperature 

and Humidity sensor added.

Internal Tilt/Roll – Relates to the ShockLog 298 with the factory optional sensor added to detect tilt & roll.

GPS Module – refers to ShockLog 298 with optional GPS module to record GPS coordinates of an impact and 

coordinates when a time slot summary is made.

RF Communications – Relates to the ShockLog 298 with the factory optional ZigBee radio module being added to 

transmit data files wirelessly in a stationary environment.



25This document is written and published by ShockWatch, Inc. All rights reserved.

USER MANUAL

PERIPHERALS

Optional accessories may be added to the ShockLog setup. 

 • RD299 HPT – Humidity, Pressure, Temperature Sensor

 • RD400 Remote Accelerometer – Legacy product supported by ShockLog RD298 – recorded single access  

  acceleration in a location remote from the ShockLog. 

 • RD401 Remote Indicator – Legacy product supported by ShockLog RD298 – brought alarm warning lights to  

  a location away from the ShockLog.

 • RD404 Tilt & Roll – Legacy product – external tilt and roll accelerometer

 • Satellite / Cellular – Accessories available to provide near-real time impact notification and location  

  information. Communication modules transmit information to SpotSee Cloud. For additional information  

  regarding connected devices, please refer to Appendix A - ShockLog Satellite or Appendix B - ShockLog Cellular  

  and Appendix C - SpotSee Cloud Platform.  

 • External – custom connection; discuss additional input requirements with your SpotSee representative.

Click the box for any options that will be utilized with the ShockLog, then click “Continue.”

RD401

These settings are available for a customized legacy solution from SpotSee. They are not supported by the ShockLog 

298 or 248.

IBUTTON PASSWORD

Users are able to create password protection in the iButton system. These passwords prevent unauthorized users 

from interfering with the ShockLog through the iButton interface. To create password protection on the iButton 

interface, users program the ShockLog with their own password (up to 8 characters in length and case sensitive). 

Any iButton used to communicate with the ShockLog must be programmed with the same password. Otherwise, 

the ShockLog ignores the iButton.

The Password is created by clicking in the Password box and typing in the password. The password is confirmed by 

typing in the confirm box. The confirmation passwords must be exactly the same as the original password.
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SETTINGS
The Settings window allows the user to select the protocol, create setup name, enter mission comment and set 

start date.

PROTOCOL

Protocol 400 is the appropriate setting unless the RF module is installed and being used. If the ShockLog has an RF 

module installed, P400 and ZigBee should automatically set. Verify the correct protocol when using the ShockLog 

298 RF unit.

MISSION COMMENT

Users can add notes to the setup file and these notes will be recorded by the ShockLog. These comments will be 

displayed on the Report screen when the file is downloaded.

SETUP NAME

Users are able to name their setup and save it as a unique file for future use. With a new setup the word “Default” 

will be in the setup name field. The user must change this name before they are able to save the setup, send it to a 

ShockLog unit or move onto the next stage of the setup process.

TIP:  If you have a setup you want to use as the preferred setup, make this the user default by going to the 

options screen, double clicking on the user default setup box and selecting your setup file name.
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START DATE

SLOT CONTENTS

If the user would like the ShockLog unit to begin monitoring at a future date/time, click on the right-hand arrow to 

bring up a calendar selector and select the desired date. If the unit should start recording at a specific time, it is 

possible to set the start time as required. The start time will be +/- 10 minutes of the specified start time.

Slot contents define the criteria to be recorded in the Slots graphs. Select the parameters of interest by clicking the  

appropriate boxes. The four default settings are max peak x, y, z and internal temperature. Depending on the 

configuration of the ShockLog, the available slots include max / min peak for the three axes, temperature, humidity, 

dew point, pressure, tilt and roll. Setting threshold limits for these values will be done in the Slot Alarms and T&R 

alarms sections.

TIP:  It is possible to start the ShockLog sooner than the Start Date by connecting the ShockLog via USB to 

the PC, opening the software and clicking “Start” in the Communications Window. This action will override the 

delayed start, and the ShockLog will begin recording immediately.

The “Start” iButton being applied to the reader port will also override the delayed start and begin the recording.

SLOTS
Slots are user defined periods of time in which various criteria will be recorded.
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TIP:  Selecting additional parameters will decrease the amount of time in which data can be recorded. Only 

select parameters that are of interest in order to maximize recording time available.

SLOT INTERVAL

The Slot Interval defines the how often a time slot will be recorded. The window below the Slot Interval setting will 

show how long the maximum number of slots and run time based on the setting. 

TIP:  Battery life is not affected by time slot frequency.  

It is advisable to always select a time slot interval that will last longer than the expected journey length.

SUMMARY INTERVAL

Summaries provide an overview of what was recorded by the ShockLog in a given period of time (the summary 

interval). A summary records the number of warnings/alarms and the maximum recorded slot values in the 

summary interval. The Summary Interval allows the user to set the time period between each summary period.

TIP:  Battery life is not affected by summary interval setting.  

It is advisable to always select a summary interval that will last longer than the expected journey length.

JOURNEY DURATION OPTION FOR SLOT & SUMMARY INTERVALS

The Journey Duration button allows users to select the expected journey length, and the ShockLog will automatically 

optimize the slot and summary intervals settings.

NOTE

It is important for users to allow for potential delays during the journey or through customs. The journey 

duration should always be set slightly longer than the expected journey length to prevent the possibility of 

losing end of journey information  
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EVENTS
Impacts above the user defined threshold are defined as events. The Events section allows the user to define the 

criteria to be considered when recording a potentially damaging event.

RECORD

This section allows users to specify the resolution / memory to be allocated to each event. From the resolution and 

memory setting, the number of recorded events is calculated by the software.

LENGTH

The more memory allocated to an event, the more points the event graph will display, and the higher the event 

resolution will be. The ShockLog always records 4096 samples per second. However, the ShockLog will compress 

saved data according to how long the event is. The peak of an event will not be lost when data is compressed as the 

ShockLog always keeps the max & min samples of each compressed data section.

TIP:  Generally, it is desirable to log detailed events when damage may have occurred to the shipment. 

Settings that allow for the maximum number of events is not always advisable.  

The user must determine if having fewer, more detailed events or more events with less resolution is  

more desirable.

Remember that a time slot graph capturing the max peak in a time slot is produced for the entire journey.
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MAX TIME

Max time is the length of any recorded event. All events are recorded for at least 1 second. The longer the event, 

the more the data will be compressed. In certain situations, it may be desirable for the ShockLog to record the full 

length of an event (potentially up to 128 seconds). If this is the case, the “Always Max” box must be selected. In 

general, this setting is only used in a test environment, as most impact events are less than 1 second in duration.

Unless there is a specific reason to do so, do not use the Always Max setting. Let the ShockLog decide when the 

event has finished by the dropout threshold. The dropout threshold is covered in the Understanding Threshold 

Levels  section.

ORDERED DATA

Unless Always Max is selected, the ShockLog will record events in an uncompressed format displaying the full 

4096 samples per second.

THRESHOLDS

Range ‘g’ or ‘Velocity’

The range field sets the maximum g-level to be recorded by the ShockLog. To set the ‘g’ range, click the drop-down  

menu and view all the possible ranges (1, 3, 10, 30, 100 & 200). The ShockLog 298 has the ability to record in 

velocity; this will automatically occur if a range in cm/s is selected. However, most users are interested in g-range.

Hardware Filter

After the range is selected, set the frequency cut off of the hardware filters to be applied to the event data. These 

filters enable users to reduce the number of unwanted higher frequency events where it is known that this type of 

event will not cause damage to the object being monitored.

The lower the filter frequency, the more severe it is in eliminating high-frequency events. The lower frequency 

filters are generally used for large heavy objects with a high metallic content, especially where the object is prone

TIP:  Selecting the range is a very important part of the ShockLog setup. Be aware of what impact levels are of 

interest. Do not assume if the ShockLog is set to the 100g range everything will be recorded. In this scenario, 

the resolution will be compromised, and low-level events may not be recorded at all. The wake-up threshold 

for a detailed event must be at least 5% of range (and recommended to be no less than 10%). On a 100g range, 

events lower than 10g with a 10% wake up threshold will not be recorded.

It is impossible to make exact recommendations for the range on a particular shipment. However, as a rule of  

thumb, the larger and heavier the object, the less acceleration (g) it takes to damage. Therefore, the 10g range 

is generally used for large objects (e.g. something weighing tons). The 30g, 100g and 200g ranges are used for 

lighter shipments.
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to high levels of resonance. These resonances will create a “bell-like” ring that a ShockLog can detect as a high g 

event if the appropriate filters are not applied. Filters are recommended in environments where a high frequency 

vibration is probable such as rail freight applications. The correct use of filters can eliminate any unwanted events 

being recorded. If gRMS is to be recorded, the frequency filter must be set to 250Hz.

Options

The user selects one of four modes for the thresholds.  

Basic – The default setting is “Basic.” The Warning level and the Alarm level can be adjusted by the user.  The 

wakeup and dropout levels are set automatically in the software based on the warning level selected.

Multiple – Allows the user to set all four thresholds (wake, warning, alarm, and dropout). The user is also able to 

adjust the thresholds for each axis independently.

Link XYZ - All of the axes operate off of the same thresholds. 

Timed Events - Allows users to record a detailed event at the end of every summary period. This setting is not 

dependent on thresholds being breached. Timed Events is an option for the ShockLog 298 only.

UNDERSTANDING THRESHOLD LEVELS 

The threshold settings determine what level of impact will cause the ShockLog to wake up, the levels at which a 

warning or alarm is created, and the dropout level of the event. The simple bar chart below can best explain  

these thresholds.

It is not desirable for the ShockLog to constantly be awake due to low level vibration caused by the mode of 

transport. The ShockLog uses 100 times more battery power when it is recording at higher resolutions than when 

it is monitoring peak time slot values for wakeup thresholds. The ShockLog can easily see 0.5 to 1g of activity when 

being transported in a car on normal roads.

Alarm threshold

Warning threshold

Wake up threshold

Drop out threshold
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If any accelerometer activity exceeds the wake-up threshold, the ShockLog will start recording accelerometer 

data at a faster rate. The ShockLog takes 0.25 msec to start recording higher resolution data once the wake-up 

threshold has been exceeded. If the activity does not exceed the warning level and drops below the wake-up 

threshold, the ShockLog will go back to monitoring time slot peaks. An event will not be recorded.

When the wake-up threshold and the warning levels have been breached, the ShockLog will record a detailed 

event and flag it as a warning. The same logic is applied when the alarm threshold level is breached. The ShockLog 

will record a detailed event and flag it as an alarm.

Once the event activity has dropped below the drop out threshold (or reached the maximum allowed event length), 

the ShockLog will stop the dynamic event recording and go back to monitoring peak values during time slots.

“Wake”

The level at which the ShockLog will wake up and begin recording. The wake-up threshold should be set to 

approximately 80% of the warning level.

“Warn and Alarm”

Warning and alarm events are recorded in exactly the same way. The thresholds distinguish how the events are  

flagged in the ShockLog data file and how the LEDs on the ShockLog unit flash once a threshold has been breached.

“Drop out”

The acceleration level at which the ShockLog will stop recording an event provided it has been set to record for 

longer than 1 second and the “Always Max” box has not been selected. The drop out level should be no lower than 

the wake-up threshold and can be as high as the warning.

If you are unsure of how to set your thresholds, please contact SpotSee Technical Support for assistance.

TIP:  It is not advisable to use wake up or drop out thresholds of less than 10%. However, it is possible to set 

levels down to 5% if necessary.

TIP:  Warning and alarm thresholds become more important when the ShockLog LEDs are to be used as part 

of a shipment’s receiving audit. Example: Set a warning level to indicate the shipment should be quarantined 

pending further investigation. Set the alarm threshold to indicate the shipment must be inspected without delay.
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ENVIRONMENT

When temperature, humidity, and pressure sensors are to be used, the environment section allows users to set 

low and high thresholds for these parameters. This section is where settings are made for both factory installed 

temperature/humidity sensors or the external temperature/humidity/pressure sensor.

SLOT ALARMS
The Slot Alarms window allows the user to specify alarm settings depending on the factory options and peripherals 

that have been specified in the Firmware Options tab.

GRMS (VIBRATION)

gRMS alarms allow ShockLog 298 users to set slot alarms for gRMS data. In the setup window, users must select 

the gRMS option (Firmware Options) for this measurement to be available. 

Users should enable the axes for which a gRMS alarm is required and set the level as a percentage of the shock range.
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T&R ALARMS

FINISH

The T&R Alarm window is used when either the Tilt & Roll option (internal) has been purchased as part of the 

ShockLog 298 or the legacy Tilt & Roll accelerometer (external) is being used. The alarms of interest should be 

enabled, and the degree of tilt / roll should be entered by the user. Alarms can be set for both upper and lower 

levels for tilt and roll.  

The Finish window provides a summary of the settings and provides an opportunity to save the setup file and send 

it to the ShockLog.
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SAVING SETUP FILE

SENDING SETUP TO SHOCKLOG

After a setup has been defined, it must be saved before it can be sent to a ShockLog. 

Click the disk save icon to save the file.   

The system will automatically save the file in the default setup directory and can be retrieved for editing or sending 

to a ShockLog at any time.

Once the setup has been created and saved, it can be sent to the ShockLog.  

Connect the ShockLog via the USB cable to the PC and click the “Play” icon.  

The status bar at the bottom of the screen will change to “OK” once the file has been successfully sent.
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Once the ShockLog has been programmed, the unit must be started to begin recording. It is recommended that 

the ShockLog be mounted prior to starting the recording to prevent the capture of impacts resulting from the 

mounting process.

Depending on how the device was configured during the setup process, the device may have a preprogrammed 

start date. If so, the ShockLog will begin recording with no additional user interaction.  

However, it is possible to start the ShockLog by connecting the ShockLog via USB to the PC, opening the software 

and clicking “Start” in the Communications Window. This action will override a preprogrammed start date, and the 

ShockLog will begin recording immediately. 

The “Start” iButton being applied to the reader port will also override the delayed start and begin the recording.  

Remove the black center cap from the ShockLog iButton port and insert the START iButton into the port. When 

the iButton LED on the ShockLog is red and the Slot Alarm LED is green, remove the iButton. The unit will start 

recording in one minute.

START MONITORING

UNDERSTANDING THE STATUS LEDS
ShockLog units have three status LEDs that display the unit’s condition:

1.  iButton

 •  Single color LED (red)

 •  Illuminated when a valid iButton is inserted

 •  Used in conjunction with the SLOT ALARM LED, which flashes green when the iButton command is accepted

2. Slot Alarm

 •  Tri-color LED (green, amber & red)

 •  Flashes every ten (10) seconds when in Waiting State, or every five (5) seconds when in Running State

 •  Condition

 •  No slot alarms - Flashes green

 •  One or more slot alarms - Flashes red
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3. Event Alarm

 •  Tri-color LED (green, amber & red)

 •  Flashes every ten (10) seconds when in Waiting State, or every five (5) seconds when in Running State

 •  Condition

 •  No events - Flashes green

 •  Warning event(s) recorded (with no Alarm events) - Flashes amber

 •  Alarm event recorded - Flashes red

For ShockLog units with firmware v27 and above, All LED’s flash red every ten (10) seconds when the unit is in the 

Stopped state.

STOPPING THE SHOCKLOG SATELLITE

The ShockLog can be stopped with the Stop ibutton or it can be stopped after connecting the ShockLog to a USB 

port. To prevent capturing impact events resulting from dismounting the ShockLog, a best practice is to use the 

Stop ibutton.

Remove the black plug from the ibutton port.

Insert the STOP ibutton into the ibutton port.

All three LEDs will flash red every ten (10) seconds when the unit has been stopped.
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Two methods are available for downloading the ShockLog: connection 

through a USB port or through an RF connection (ShockLog 298 only).

USB COMMUNICATION
Open the Communications Window and connect a ShockLog through the USB to the PC. The ShockLog USB port 

is on the side of the ShockLog under a silver screw connector. The Communication Window information boxes 

will automatically update from the ShockLog. With ShockLog software version 9.x and greater, it is possible to 

communicate with both the latest generation of ShockLog products and legacy products.

The Communication window information includes the following parameters:

Model: Variant of the ShockLog attached i.e. ShockLog 298, 248, ShockLog RD298 or RD317.

Serial Number: Serial number of the attached  

ShockLog; this field will not populate for most 

legacy products. The ShockLog serial number is 

located on the side label of the ShockLog below 

the model number. For older units, the serial 

number will be engraved on the side of the 

ShockLog above the USB port.

Version: Firmware code version of the attached ShockLog.

State: Operating state of the ShockLog: Waiting, Running or Stopped.

Connection: Type of connection currently utilized to communicate with the ShockLog

Date / Time: Date and time set in the ShockLog unit; this field will update every 10 seconds while the unit  

is connected.

Range: G range set in the attached unit.

DOWNLOADING THE SHOCKLOG
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RADIO DOCKABLE WINDOW

To enable the ShockLog software to communicate with the RF Base unit, a special “Radio” dockable window is 

available. Users are able to open the Radio window from the New Windows option in the window menu. Once 

opened, the window can be docked on the screen in the same manner as all of the other windows.

The radio window enables users to view and communicate with all available ShockLog 298RF units that are in 

range of the RF Base Unit. Users are be able to download data; send set up files, set the clock of the remote 

ShockLog 298RF units; and configure the RF Base unit from this window. A list of ShockLog units connected 

through the RF link will automatically populate in the Radio window.  In order to communicate with the ShockLog, 

the appropriate ShockLog should be highlighted. This step is not necessary when the ShockLog is communicating 

with the base unit. When downloading data from the ShockLog over the RF connection, the download time can 

take several minutes depending on the amount of data to be downloaded.  
 

The RF Base unit must be plugged into a PC for it to operate. It may take as long as 15 minutes for the base unit 

and the ShockLog to establish initial communication.  

When an event occurs that is above the thresholds, the ShockLog will transmit an alarm notification to the PC 

where the base unit is connected. Alarm notification will include ShockLog serial number for quick identification of 

which unit has experienced an event. New alarms will accumulate until “Accept” has been clicked. This allows the 

user to acknowledge that the ShockLog has alarms and take actions appropriate to their operating procedures. 

Setup Passwords and Security Log can be activated from the View menu at the top of the screen. Once activated 

the buttons enable users to setup passwords and view the security log of the attached ShockLog. These 

capabilities are described in more detail later in this manual.

RF COMMUNICATIONS
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A summary of information will be visible in the Radio window – number of slot alarms, event alarms and warnings, 

date and time as well as an indication of signal strength. The number of alarms includes the total number of 

alarms experienced during the measurement period.
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OVERVIEW OF SOFTWARE SCREENS

FILE VIEWER WINDOW
The File Viewer Window is the main section 

of the software window and displays all of 

the information related to the selected file. 

EXPLORER WINDOW
The Explorer window provides a list of all available data files in the main 

database. Click on any of the files and the report data will appear in the 

File Viewer. The file data in the Explorer window will break down into more 

detail showing Events, Summaries and Slots.

Click on “Events” in the Explorer window, and the system will display the 

individual events. By selecting any of the events, the “File Viewer” will 

display the detailed curve for that event.

RECORD TABLE
The Record Table window provides an alternative view of the data files in the database. It provides the user with 

an overview of the number of Events, Warnings, Alarms, Summaries and Slots. It is also possible to see the user 

comment associated with the file. The user comment can make the date more meaningful to the person reviewing 

the data.

REPORT
In the File Viewer, the Report View is the  

first screen displayed. The report provides 

an overview of the entire journey, storage 

period, experiment, etc. Information is 

provided in text and graphs. The Report 

will be discussed in greater detail in the 

Analyzing the ShockLog Data section.
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From this screen, users have the ability to sort the database by the columns of data. This feature will be discussed 

in more detail in the Analyzing the ShockLog Data section of the manual.

EVENT TABLE
When a file with “Events” is selected, the “Event Table” will refresh to display details of all the events associated 

with the highlighted data file. The “Event Table” displays the Event Number; Event Date; Duration (seconds); Range; 

Rate (samples recorded per second); Temperature; Max X,Y,Z (highest G measurement in each axis during the 

event) and the Modulus value of the event.

Click on the Event number and the File Viewer will change to display the detailed event curve for the selected event.

It is possible to move from the Event Table to the relevant slot graph by clicking “Show Slots” next to the desired event.
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COMMUNICATIONS WINDOW

VIEW SETUP RECORD 

The Communications Window displays live data from a connected ShockLog. It allows a user to perform tasks 

while connected to the ShockLog. Information displayed in the Communications Window includes: Model of the 

ShockLog connected, Serial Number (not available on legacy products), Version of firmware, State (running or 

stopped), Connection (USB or Serial), Date/Time, Range (impact scale), Status (alerts if memory is full), Alarms 

(number recorded) and Protocol of the attached ShockLog.

With a ShockLog unit attached to the PC, it is possible to view the setup file on the screen.

From the “Communications” window, select the ‘Read Setup’ button and the PC software will interrogate the 

attached ShockLog displaying the installed set-up in the setup window. It is possible to save the set-up file to the 

local PC, and users will be offered this option as they close the setup window.

In the Communications Window, it is possible to perform a variety of functions:

Download: Downloads data from the ShockLog.

Start: If a ShockLog is in a stopped state, “Start” will restart the unit.

Send Setup: Sends a new setup to a ShockLog and clears the ShockLog memory.

Set Clock: Sets the clock of the ShockLog to match the PC.

Stop: If a ShockLog is in a running state, “Stop” will stop the unit.

Read Setup: Allows the user to read the setup data and save as a separate setup file for future use.

In addition to the above buttons, two others are grayed out. “Setup Passwords” and “Security Log” are specialist 

functions and will be explained in the iButton Communications section.

NOTE

While unlikely, if the Communication Window is opened, a ShockLog is connected and the information does 

not update, disconnect and reconnect the ShockLog device to reactivate the window.
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SLOT BREAKS GRID
The Slot Breaks table displays a list of breaks in the Time Slot data. These breaks can include all communication 

with an iButton, the first slot record or could relate to alarm resets from a Remote Monitoring System. The list will 

be shown in date/time order and will indicate what slot had a break in it and what the break event was. To access 

the Slot Break table select “Windows,” “New Window” then “Slot Breaks Grid.” 

To view the slot breaks on the time slot graphs, double click on any of the slot breaks in the table and the software 

will link to the appropriate time slot period on the graph.

On the slot graphs, slot breaks are represented by a grey vertical line. Click one of the grey lines, and a text box 

will appear on the right side of the graph. The text box will provide details regarding what caused the slot break 

and the slot number of interest. It is possible for more than one slot break to occur in a single time slot period. If 

this is the case, the text box will list all of the slot breaks in time order. 

If the last slot break is selected, a red line will illustrate the end of the final slot.
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ANALYZING THE SHOCKLOG DATA

REPORT 
When a file is opened, the Report View is displayed. The report provides an overview of the entire file (journey / 

storage period experiment), providing information in both text and graphical formats.

The text data is broken down into two separate tables providing the following data:

DATA FILE SUMMARY 

The file summary provides an 

overview of the ShockLog that was  

deployed for the journey and 

summary information regarding the 

actual journey.

Model: ShockLog model used for the data file 298 and 248 denote the latest ShockLog ranges, and RD298 & RD317 

are the legacy products.

Journey Start: Date the unit started to record the data file.

Journey End: Date the unit stopped recording the data file.
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Report Start: Beginning date of the report. If the report has been adjusted to display only a section of the data file, 

this field provides the starting point. Data viewed on the Report page will begin with the Report Start Date.

Report End: Date the data on the report ends. If the report has been adjusted to display only a section of the data 

file, this field provides the end point. Data viewed on the Report page will end with the Report End Date.

Download Date: When the data file was extracted from the ShockLog unit. 

Recorded Duration: Length of time the ShockLog recorder actually recorded data.

Serial No: Serial number of the ShockLog unit that recorded the data file. 

REPORT TIME PERIOD SELECTOR  

First Alarm: Provides details of the first alarm event that was recorded, it includes Event Number, Axis, Date/Time, 

Modulus (g) and Temperature at time of event.

First Warning: Provides details of the first warning event that was recorded. It includes Event Number, Axis, Date/

Time, Modulus (g) and Temperature at time of event.

Note: First Warning is only applicable to the 298 and RD298 versions.

Most Severe: Provides details of the most severe event recorded. It includes Event Number, Axis, Date/ Time, 

Modulus (g) and Temperature at time of event.

Event Summary: Provides the quantity of events (Warnings and Alarms) which occurred

Max XYZ: Lists the event that had the maximum acceleration / duration for all three axes. Event number, 

Acceleration, Duration

SUMMARY OF EVENTS 

The summary of 

events provides 

details of the Events 

seen in the data file.

There may be circumstances when showing the complete data file of a journey, test or storage period is not necessary. 

When a smaller section of time within the recorded data is of interest, the ShockLog software incorporates a “report 

time period selector” that allows users to define the time period of interest and hide the remaining of the data. As a  

safe guard to prevent abuse of this feature, the ShockLog software always displays the complete recorded period and  

the actual time period being displayed for the graphical data in the file. The report time period selector does not delete 



47This document is written and published by ShockWatch, Inc. All rights reserved.

USER MANUAL

the full data set; it only allows the report to focus on the areas of interest. This information can be found in the trip 

summary section of the Report.  

At the top right-hand corner of the File View window, just below the tabs, there are two drop down windows with 

dates. When opening a new file these will represent the start and end dates / time of any given file.

The start and finish date / time of the report displayed can be amended by either changing the date & time in a 

calendar drop down option or by using a slide bar, both of which are activated by checking the appropriate check 

box for either the report start or report end boxes.

With the calendar system, when a user clicks on the drop-down menu, a calendar for selecting the required start 

or end date will appear. Note: it is necessary to click on both the start and end check boxes and drop-down menus 

independently. The dates cannot both be changed through a single calendar screen.

From the drop-down screen, a user can select a new start date for the report. Once the date is selected, it is 

possible to amend the start time by typing over the time next to the selected date.

After making these amendments, the main report within the file viewer window changes to display only the 

information after the selected start date, ignoring all earlier information. However, the “Recorded Period” shown in 

the information box will not change.

To use the slide bar, place the cursor over the moving bar, press and hold the left mouse button and drag the bar 

to the approximate time desired. The main report will update automatically. The date and time being displayed will 

change in the window so the user is able to track the position in the report.

The same process is used to change the end dates of a report. This function makes it possible to create custom 

reports for different periods of the file.

In addition to the text data, the Report provides  

three data graphs.

SLOT GRAPH 

X, Y and Z axis impacts, as well as the internal temperature, 

are the default graphs that appear in the Report. Users can 

select different data channels as required. This process is 

described in the Creating a Setup File section.
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SLOT GRAPH SELECTION

When a data file is first opened, the report tab will display four time slot graphs, usually X, Y & Z acceleration and 

Internal Temperature. These values will vary depending on what was selected for the recorded period.

To view any of the alternative channels of information recorded during this file, the user can change the  

display selection.

However, a maximum of four graphs can be displayed at any given time. If a user needs to view more than four, it 

is necessary to go to the Slots Tab where all recorded time slot parameters can be viewed.

To change the selected Graphs, select the arrow of the ‘Select Slot’ drop down menu. A list of all the available slot 

graphs that have been recorded in the data file and the four graphs currently being displayed will be checked. To 

change the selection, uncheck the graphs no longer of interest and check those that should be displayed.

When the desired channels have been selected, the report will automatically update and display the revised charts.

Click on the arrow to go back to the report. 

The display can be changed as many times as desired and the various versions can be printed for the record.
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EVENT DATA GRAPHS

EVENT SUMMARY GRAPH

The right side of the Report Tab contains information about the event data recorded. This section will appear blank 

when viewing a file where no event has been recorded.

The data is split into two different graphs:  Event Summary and Detailed Event Curve.

This bar chart graph shows the modulus value of all events recorded within the data file and highlights the most 

severe event by displaying it in red.

When a data file is first opened, the most severe event is not only highlighted in red but also has a red cursor bar 

running through it. The cursor bar is used to show which event is being displayed in the detailed event curve below 

and can be moved by clicking on another event (bar).

It is possible to zoom in on smaller proportions of the summary chart and highlight the area of events that are of 

interest. The events are listed in the order they occurred. Events may be within minutes or days of each other.

To zoom in on an area, click and hold the left mouse key on the first event of interest and drag the mouse to the 

last event of interest. The events of interest will be the area of focus. Changing the date selection as described in 

the Report Time Period Selector section will have a similar effect on the summary chart.

After zooming in on an area, it is possible to move through the events by using the slide bar at the bottom of the chart.

By clicking on any of the visible events, the detailed event curve below will change.

To return to the full screen, click the button at the left-hand end of the slide bar.
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DETAILED EVENT CURVE

DRAG ‘N’ ZOOM

The event curve displays the detailed data curve for a given event. It will display the most severe event when the 

report is first opened. Different events are displayed by clicking on them from the Event Summary Graph. The 

detailed event curve shows the magnitude and duration of the impact event, with the horizontal axis displaying 

the time in milliseconds and the vertical axis showing the force of the impact in g. All three axes will be displayed 

giving users a full understanding of the level of impact seen across all axes.

Like the summary event graph, it is possible to zoom in on the most relevant areas of a detailed event graph 

allowing users to see the area of most interest.

In order to zoom, place the cursor at the beginning of the area of interest, click and hold the left mouse button 

and drag it to the end of the relevant area.

In this example, the area between 0 and 100 milliseconds is of interest.  By zooming in, the first 10% of the event 

can be displayed with more visual detail. This area is where most of the event activity occurred.

If desired, it is possible to zoom in further. The same method for zooming is used. It is possible to move backwards 

and forwards along the event time line utilizing the slide bar at the bottom of the chart. To return to the previous 

graph/zoom, click on the button to the left of the slide bar.
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SETTINGS
The settings tab provides a summary of the ShockLog setup associated with the data file. Information regarding 

the accelerometer, event, slot and summary settings is detailed.

Setup Name: The name of the setup used for the data file. 

Mission Comment: Displays the mission comment if one was entered during the creation of the setup file.

Accelerometers:  Displays the following information:

 Range Acceleration or velocity range selected (or factory set).

 Wake (%)  Accelerometer wakeup level of the processor; set as a percentage of the range and is point at which   
  the processor will wake up and start to record at full speed in preparation of an event.

 Warn (%)  Applies only to the ShockLog 298 and RD298; shows the g value (X, Y, Z) at which events will be  
  recorded as a warning. Each individual axis can be set to a different sensitivity based on the  
  requirement of the product being monitored.

 Alarm (%)  Shows the g value (X, Y, Z) at which events will be recorded as an alarm. Each individual axis can be   
  set to a different sensitivity based on the requirement of the product being monitored.

 Drop Out (%) Applies only to the ShockLog 298 and RD298; shows the g value (X, Y, Z) at which events will stop  
  recording once they have passed 1 second and are not set to “Always Max.” Each individual axis can  
  be set to a different sensitivity based on the requirement of the product being monitored.

Hardware Filter: Displays the hardware filter selected

Events:  Displays the following information:

 Record Length Provides information about the amount of memory allocated to each event. For this case, 32K is the  
  largest amount.

 Max Record Time  Shows the maximum length of time an event is recorded. If the ‘Always Max’ is set to Yes, the max  
  record time is the length of every event. If not set to Yes, max record time will record an event  
  between 1 second and this maximum figure, depending upon when the drop out level is reached.

 Max. No Events  Shows the maximum number of events that the ShockLog recorder is capable of recording with  
  these settings.
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 Filter Frequency  Displays the selected hardware filter frequency 

 Always Max If this is set, an event will always record for the maximum length set and drop out threshold is ignored.

Slots:  Displays the following information:

 Interval  The time slot interval setting, i.e. the length of time each time slot is measured. 

 Total Run Time Shows the maximum length of time that the unit is able to record before the time slot memory is full.

 Max No Slots Shows the total number of time slot periods that are available for each channel of data.

 No. Content Set  Shows the number of channels selected. Channels can include: Max  X, Y & Z, Min X, Y & Z, grms X, Y  
  & Z, Internal Temperature, External Temperature, Humidity, Pressure, Dew Point, Tilt & Roll and  
  External Channels.

 No. Alarms Set   Shows the number of Slot Alarms that have been set in relation to the channels of data being recorded.  
  Slot alarms can include high/low temperature, humidity & pressure, angles of tilt or roll as well as   
  impact alarms. 

Summaries: Report will display the following information:

 Interval  Shows the length of time between each summary record. For this example, the interval is every  
  30 minutes.

 Total Run Time  The maximum length of time that the unit can record before the summary memory is full.

Standard Options, Factory Options, and Peripherals display the options selected in the setup.

SLOTS 
In the File Viewer, selecting Slots tab will bring up a new screen displaying a number of time slot bar graphs in 

relation to the data file currently being viewed. This tab provides the user a more detailed view of all the available 

slot data. On the right side of the screen text data will be presented in relation to the graphs displayed. Just below 

the tabs, the options of Select Slots, Show Events and Export are available. This section will detail how these 

functions operate. With the graphs themselves, the Y axis will display the unit of measure for the given channel of 

data (i.e. g, temperature, etc.), and the X axis displays the slot number.
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The text information on the right side of the screen provides additional 

information about the slot graph being viewed. More specifically, it 

provides information regarding the highlighted area or where the cursor is 

positioned. When the slot tab is first selected, the cursor will be at the far 

left zero position and is depicted by a red line.

The information is displayed in bar chart format and can include the following:

Acceleration (X, Y & Z): Peak acceleration max or min recorded in g or cm/s

Temperature: Peak value recorded in Celsius or Fahrenheit. 

Humidity: Peak value recorded as a percentage.

Dew Point: Calculated based upon the temperature and humidity recorded.

Pressure: Peak value recorded in BAR.

Tilt & Roll: Maximum angle of movement, recorded as degrees of angle +/- 180 degrees.

g-RMS: Calculated RMS values based on the acceleration data captured within the time slots.

The information is displayed in bar chart format and can include the following:

Graph Type: Tells the user which channel of information is being displayed in the slot graph. In this example 

MaxPKX, the maximum peak values seen on the X axis is being displayed.
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Value at Cursor: Shows the channel value where the cursor has been positioned. In this example, it is at zero, 

because the cursor has not been moved from its original starting position. This feature can be used to highlight 

spikes/peaks in the data and quickly ascertain actual values at these points.

Time at Cursor: Allows the user to see the date and time at each slot point so that a peak value can quickly be 

associated to a place and potentially a responsible person or organization.

Maximum in View: Considers all the values for this channel currently visible on the graph and will tell the user the 

highest value seen. As the user zooms in on the data, this value potentially will change if the original peak in not in 

the zoomed area.

Minimum in View: Considers all the values for this channel currently visible on the graph and will tell the user the 

lowest value seen. Generally, this feature is more useful for the environmental parameters such as temperature 

and humidity where it will display the upper and lower limits for the displayed period. For the impact graphs this 

value will be displayed as zero.

Slot Breaks: Only appears when slot breaks are displayed at the same point as the cursor on the graph and are 

indicated by a grey vertical line. The values will correspond with the Slot Break table.

To get a quick snapshot of the values associated with a bar on any of the graphs, hold the mouse cursor over any 

of the individual bars and click the right mouse button. This action will display a small text box next to your cursor 

displaying the data value at that point, i.e. the peak acceleration value, as well as the date and time of the data 

point. The text box will appear for about 5 seconds before clearing.

Each parameter recorded requires a set amount of memory. Increasing the number of parameters recorded in the 

slots will decrease the available recording time. Users must balance the measurement parameter requirements 

and memory to ensure that appropriate data is captured for the entire recording period.

SELECT SLOTS

As a default, when viewing the slot graphs all recorded channels will be shown on the slot tab. By scrolling down 

with the slide bar or the center wheel of the mouse, it is possible to view the various graphs. In order to simplify 

the interpretation of the recorded data, it may not be appropriate to view all the available graphs. Using the Select 

Slots drop-down menu, it is possible to select and unselect channels of data as appropriate. It is not possible to 

change the order in which the graphs are displayed; the graphs can be viewed or not viewed in the given order.

When the appropriate graphs have been selected, click onto the graphs and the drop-down menu will clear. The 

graphs being displayed can be changed at any time.
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TILT & ROLL

These two data points are separated into two graphs, 

named Roll Traces and Tilt Traces. Any breaks in the 

communication channel that can occur during the 

recording period are represented as a red cross on  

the respective graph.

DRAG ‘N’ ZOOM

When viewing the slot graphs, the default will scale the graphs to fit the complete recording period on the screen. 

The system will compress the data and merge several time slots into each bar of the chart making it difficult to 

focus on specific time periods within the recorded data.

To assist in this area, the ShockLog software allows the user to zoom into specific areas of the graph and highlight 

the key, potentially damaging areas of information. The process of zooming in is very simple. Placing the mouse 

cursor at the beginning of the period of interest, click and hold the left mouse button, drag it to the end of the 

period of interest, and release.

The graph will zoom in to display the highlighted area as a full screen view. This zoom area will be reflected in all 

the graphs displayed. It is not possible to zoom in on only one of the graphs.

It is possible to continue zooming in until each individual time slot is displayed as a separate bar within the graph, 

making it easier to identify potential damage creating time slots. When positioning the cursor to create the text 

information, it is necessary to position the cursor to the left side of the bar chart, as this is the point recognized by 

the system for each time slot period.

ZOOM ALL

Pressing this button allows the user to return to the original view of the graph, canceling all zoomed-in areas.

SHOW EVENTS

The ShockLog software has been written with several hyperlinks enabling the user to move between relevant 

sections of data. From the Slot graphs, it is possible to jump to the detailed event curves associated with the 

period of time being displayed by the slot graphs. When first entering the slot tab, the user is presented with all 

the events recorded in the data file as the whole time period will be in view. As the user zooms in, the number of 

events for the time period in view will reduce.
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All these parameters are adjustable. If the user does not wish to export an available channel of data, uncheck the 

appropriate box. Additionally, if only a proportion of the data file is of interest, the slide bars can be used to adjust 

the start and finish times of the data to be exported.

The Separator drop down menu allows the user to select the character used to separate fields in the export data.

The auto option will use the separator commonly associated with the computer’s language setting. For example, 

a comma is used in the USA or UK and a semicolon is used in France or Germany. Other languages will vary. Other 

options for a separator can be manually set via the drop-down menu as a comma, semicolon or space.

To add any of the event or summary information in addition to the slot data, simply check the appropriate boxes.  

Click the “Export” button, and when the system has finished, an export completed window will appear.

The exported data files are recorded in the Export directory under the ShockLog system. If the route to the 

directory is unknown, view the Data Path option under the tools menu, and the export folder can be found in 

the directory that holds the Data, Setup and XML files. The files can be imported into any appropriate software 

application as required.

EXPORT

From all the detailed graph tabs it is possible to 

export the raw data from the data files to allow 

manipulation of the data in alternative packages 

such as Excel and MATLAB. 

To export the Slot data from the Slots tab, click 

the “Export” button and the user will be given the 

opportunity to choose a location for the saved 

file. After naming the file and selecting save, the 

export window will appear.

In the Export window, the slot data has been 

checked with the rest being left blank. In this 

example, the six channels of slot data will  

be exported.
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SLOT ALARMS 

SUMMARIES

In the File Viewer screen, the slot alarms tab will bring up a table of slot alarm levels and indicate if they are in an 

alarm condition.

In the File Viewer screen, the Summaries tab will bring up a table of data, summarizing what has happened in each of 

the summary periods including the number of events, peak acceleration and any environmental conditions recorded.
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COLUMN DATA

The information is presented as a grid with columns of data that relate to the data file being viewed. The potential 

columns of data include:

Date/Time: Specifies the date and time of the summary record.

Warns: Specifies the number of warning events recorded in summary period. 

Alarms: Specifies the number of alarm events recorded in summary period. 

Range: Denotes either the user selected range (298) or factory set range (248). 

Max PK X, Y & Z: Records the maximum peak value recorded for each of the axes during the summary period.

RMS X, Y & Z: Records the RMS values recorded for each axis on the summary period

Max Temperature: Displays the maximum temperature recorded by the internal sensor during the summary period.

Min Temperature: Displays the minimum temperature recorded by the internal sensor during the summary period.

Max Ext. Temperature: Displays the maximum temperature recorded by the external sensor (if installed) during the 
summary period.

Min Ext. Temperature: Displays the minimum temperature recorded by the external sensor (if installed) during the  
summary period.

Max Ext. Dew Point: Displays the maximum dew point recorded by the external fitted sensor (if installed) during the 
summary period.

Min Ext. Dew Point: Displays the minimum dew point recorded by the external fitted sensor (if installed) during the 
summary period.

Max Ext. RH: Displays the maximum humidity recorded by the external fitted sensor (if installed) during the summary period.

Min Ext. RH: Displays the minimum humidity recorded by the external fitted sensor (if installed) during the summary period.

Ext. Temp Max RH: Displays the maximum temperature recorded by the external fitted sensor (if installed) during the 
summary period.

Ext. Temp Min RH: Displays the minimum temperature recorded by the external fitted sensor (if installed) during the 
summary period.

Max Pressure: Shows the maximum recorded pressure from an HPT sensor (if installed) during the summary period.

Min Pressure: Shows the minimum recorded pressure from an HPT sensor (if installed) during the summary period.

Ext Temp Max Dew Point: Shows the maximum calculated dew point from an HPT sensor (if installed) during the  
summary period.

Ext Temp Min Dew Point: Shows the minimum calculated dew point from an HPT sensor (if installed) during the  
summary period.
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SORTING SUMMARY DATA

SHOW EVENTS

SHOW SLOTS

Summary data is presented in a spreadsheet style grid and can be sorted via the column headings. An example 

is to view the data based on number of alarms. Click on the column header and the data will be sorted into 

ascending or descending order. Click again and the order will reverse. This principle applies to all the columns. For 

example, if interested in finding the summary periods with the greatest temperature, simply click on the column 

heading of “Max Ext Temp” and the whole grid will sort into the temperature order.

From the Summary tab, it is possible to jump to the detailed event curves and slot graphs associated with the 

summary period currently highlighted. The summary table will display whether warnings or alarms have occurred 

in any given period, and where events have occurred.  Click on the “Show Events” button, and the software will go 

to the first relevant event curve.

Upon clicking the Show Events button, a drop-down window showing how many events are associated with the 

visible slots will appear. Click OK and the software will go to the first of the associated events in the events tab.

To get back, click on the Summary tab.

In addition to the hyperlink to Events, the ShockLog software enables the user to link between summaries and 

relevant slot data.

Click at the top of the date & time column, and the data will be sorted back into date/time order.
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Each summary period has several time slot periods within it, and the slot graphs scales to show all the relevant slots 

for a given summary period.

To view the Slot graphs, it is necessary to click “Show Slots” in the top left menu of the Summary tab. The software 

will move to the Slots tab with the slot graphs zoomed into the summary period time frame. From here all the normal 

functionality within the Slots tab can be accessed. To get back, click on the Summary tab.

All these parameters are adjustable. For example, if there are channels of data that are not of interest simply uncheck 

the appropriate box. It is possible to use the slide bars to adjust the start and finish times of the data to be exported.

If any of the event or slot information is of interest, simply check the appropriate boxes of interest and click the 

“Export” button. When the system has finished, an export completed window will appear.

The user can select the required folder to save the exported data files in via the Browse for Folder dialog. Click OK to 

save the exported data.

For more detail on exporting data, please refer to the specific section later in this manual under Menu Options.

EXPORT

As well as being able to Export from the detailed 

graph tabs, it is possible to export the raw data 

from the summary tab allowing manipulation of 

the data in alternative packages such as Excel  

and MATLAB.

To export the summary data from the Summary 

tab, click the “Export” button and the user will be 

given the opportunity to choose a location for the 

saved file. After naming the file and selecting save, 

the export window will appear.

In the Export window, the summary data  

is checked with the rest of the fields  

being unchecked.



61This document is written and published by ShockWatch, Inc. All rights reserved.

USER MANUAL

EVENTS 
The final tab in the file viewer is the “Events Tab”. This tab displays the detailed event curves for alarm and 

warning events. Text data related to a graph is displayed. Above the text there are two arrow buttons that allow 

the user to scroll through the events. The event under examination is labeled on the left side of the event. This 

section details the different methods of interrogating the Event data to better understand the recorded data.

TEXT DATA

The text information on the right side of the screen is intended to provide additional information about the 

event graph being viewed and more specifically the area highlighted or where the cursor is positioned. When 

first entering the slot tab, the cursor is at the far-left position of zero and the cursor text information is blank. By 

clicking on a different area of the curve, the cursor bar will move, and the text field will be completed with the 

localized information. The cursor bar is depicted by a red, vertical line.

The data is split into the different axes, X, Y & Z with an E for any potential external accelerometers that may be 

installed. The information is as follows:

Date: Tells the user the date and time that the current event was recorded. The date and time are in relation to the ShockLog 
clock and won’t necessarily match that of the computer.

Value at Cursor: Shows the value in relation to the event being viewed, the individual axis and where the cursor has been 
positioned. In this display, there are four individual boxes, which represent X, Y, Z and E (E=external) and these individual 
fields will display the value seen at this point of the event.

Time at Cursor: Displays the number of milliseconds from the start of the event to the cursor location.
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Maximum in View: Considers the values for the event currently visible on the graph and tells the user the highest value seen. If 
the user zooms in on the data, this action will potentially change if the original peak is not within the zoomed area.

Minimum in View: Considers the values for the event currently visible on the graph and tells the user the lowest value seen. If 
the user zooms in on the data, this action will potentially change if the original peak is not within the zoomed area. 

X, Y, Z, E: Determines what data will be represented on the graph.  Four squares with ticks inside and a colored letter, X, Y, Z or 
E next to them represent the different axis of accelerometers represented by the colored curves on the graph. By clicking inside 
any of the boxes different axis or environmental data can be added or removed from the graph. If a specific axis of data is of 
interest, it is possible to remove all the others and focus on a single axis.

DRAG ‘N’ ZOOM

When viewing the event graphs, the default always scales the graphs to fit the complete event on the graph, 

therefore making it difficult to focus on specific time periods within the event data. In many events the actual 

period of activity of interest can be less than 200 mS. As a result, most of the graph displays as a straight line.

To assist in this area the ShockLog software allows the user to zoom into specific areas of the graph and highlight 

the key areas of information.

The process of zooming in is very simple. Place the cursor at the beginning of the period of interest, click and hold 

the left mouse button, drag the cursor to the end of the period of interest and release. The graph will zoom in 

to display the highlighted area as a full screen view. This zoom area will be reflected in all the graphs if you try to 

scroll through to other events. Once zoomed in only this range will be seen.

It is possible to continue zooming in until each individual millisecond is displayed as a separate point on the graph. 

This action would provide a very detailed analysis of the main activity within the event.

While in a zoomed in view, it is possible to scroll along the event curve using the scroll bar at the bottom of the 

graph. Click and hold on the main bar, then drag the bar left or right or click the arrows or the light grey area on 

either side of the slide bar.

To return the graph to its original position, click on the small button to the left of the scroll bar.  Clicking this 

button will step the user back one zoom level. If the graph has been zoomed in on several times, it will be 

necessary to press the button as many times to return to the original graph setting.
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FREQUENCY CALCULATIONS

The ShockLog can calculate frequency and period (duration) of an event on a per axis basis.  In the example below, 

the axis of interest is the Z axis. The X and Y axes have been deselected on the right side of the screen. To calculate 

the frequency between two points, right click on the first point and select the starting point per axis and then 

move the cursor to the ending point of interest and right click on the point. The ShockLog software will display the 

frequency and period between the two points. This feature can be used in when the data has been zoomed. To 

clear the calculations, right click and select ”Clear Freq’ Points.” 
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ZOOM ALL

SHOW SLOTS

SHOW DATA

Pressing this button allows the user to return to the original view of the graph, canceling all zoomed-in areas.

Like the Slot and Summary tabs, the Events tab contains hyperlinks that allow the user to move between relevant 

sources of data. The ShockLog software enables the user to move between Event and relevant Slot data.

When moving back to the event graph, the time slot period that the event belongs to is being displayed.

To view the Slot graphs, it is necessary to click on the button “Show Slots” in the top left corner of the Events tab.

After clicking this button, the Slots tab with the slot graphs zoomed into the appropriate time frame that the event 

relates will appear. From here all of the normal functionality within the Slots tab can be accessed. To return, click 

on the Summary tab.

While viewing the detailed event curves, the ShockLog software provides an option for users to view the 

underlying data behind each curve as it is being viewed. The data table is displayed in an Excel style spreadsheet 

showing the g values at every sample point throughout and event period.
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The columns of data include:

Sample: A straight count from zero to the maximum number of samples, with 4096 being the highest possible, for a  
given event.

Time: The number of milliseconds from the start of the event that the sample relates to.

X, Y, Z: The g value seen by each of the axes at the given sample point.

E: The value seen by the external sensor if installed.

To move up and down the list of data, use the scroll bar on the right-hand side of the screen. The data table works 

like a database and can be sorted in order to find the specific information of interest. For example, if the highest g 

value seen on the Z axis is of interest, click in the Z column header, and the data table will sort into g value order with 

the most significant at the top. If the user then wanted to know the lowest impact value, clicking the header again 

will reverse the order into the least significant g value.

This data sorting process works on all column headings. The graph will not change its view with any of the sorting; it 

will remain as the original event. To return to the original order and structure, just click on the Sample header and the 

data will sort into sample order.

All of these parameters are adjustable. If other events or the slot data on any of the available channels of data is to be 

downloaded, check the appropriate box. If the entire data file is not of interest but only a proportion is, use the slide 

bars to adjust the start and finish times of the data to be exported.

EXPORT

As with the other tab screens, it is possible to 

Export the raw data from the Events tab allowing 

manipulation of the data in alternative packages 

such as Excel and MATLAB.

To export the event data from the Event tab, click 

the “Export” button and the user will be given the 

opportunity to choose a location for the saved 

file.  After naming the file and selecting save, the 

export window will appear.

In the Export window, notice that the Event data 

is checked for the specific event being viewed and 

the rest are unchecked.
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TIP:  It is not advisable to scroll through the events when the Events data table is open as it will dramatically 

reduce the speed at which the software is able to load the next event.

To add any of the summary or slot information in addition to the event data, check the appropriate boxes to be 

exported. Click on the “Export” button, and when the system has finished an export completed window will appear.

The exported data files are recorded in the Export directory under the ShockLog system. If unsure of the route 

to this directory, view the “Data path” option under the tools menu, and the export folder can be found in the 

directory that holders the Data, Setup and XML files. The files can then be imported into any appropriate software 

application as required.

GRAPH SCALING

With the ShockLog software users have the option to choose how graph scaling is presented. The system default 

is to present the graphs on an “Auto” scaling setting that will maximize the scale to fit the page display. However, 

this can prove to be a little confusing if the user is trying to scroll through a number of events to identify the more 

significant ones as the scale will continuously changes when scrolling between the various events. It is possible to 

set the system into a “Maximum” setting that will retain the axis at the g range set for the recorded data.

To change the settings, click on the arrow next to “Graph Scaling” and select either the “Auto” or “Maximum” from 

the drop-down menu. Once changed, this setting will be applied to all future data files viewed until changed again.
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FILTERS

It is possible to post-filter collected data with the filters tool. This tool allows the user to apply a lower frequency 

filter to the measured data. The user can determine if impacts were the result of high frequency ringing versus 

longer duration impacts which can be more damaging. It is only possible to apply a lower frequency filter not a 

higher frequency filter.

To illustrate the effect that such filtering can have, the exact same data file presented is shown below with two 

different filters: 250Hz filter in Figure A and 10Hz filter in Figure B. The peak of the Z-axis is reduced from over 10G 

in Figure A to below 0.2G in Figure B.  

If you are unsure whether it is advisable to post-filter your data, please contact SpotSee Technical Support to 

discuss your application.

FIGURE A

FIGURE B
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REPORT AND POST PROCESSING OPTIONS
The ShockLog software allows users to perform several post processing functions that enable additional analysis 

of impact event waveforms. To enable these functions, select Tools>Post Processing Options. The Report & Post 

Processing Options screen will open.

FFT/PSD 

FFT tools transforms time-based data into the frequency domain. It is a mathematical method for decomposing a 

signal into its constituent frequencies.  

A signal’s spectrum is the statistical average of a certain signal as analyzed in terms of its frequency content.  PSD 

refers to the spectral energy distribution found per unit time. PSD analysis is suitable for transient events whose 

energy is concentrated around one time window.   

These two tools allow a user to transform an event in time to the frequency domain for additional analysis

Enable FFT/PSD by clicking the check box.  

Select the FFT window for the analysis.  

Note:  Windowing functions are used to smooth the effects of artificially fast transitions.
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The Rectangular (Boxcar) is the equivalent of having no windowing. The Hanning window is a common windowing 

tool. The various window tools allow the user to address the beginning and ending of an impact event which by its 

nature is not a continuous signal.     

The Report Graph View sets the scales (linear or logarithmic) of the FFT graph.

Scroll through the events until the event of interest is displayed. Turn the FFT or PSD analysis on by clicking FFT/

PST Off and selecting the desired graph view. FFT Lin/Lin was selected for the image below:
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SRS ANALYSIS

Shock response spectrum (SRS) is a means to graphically 

represent an impact event in terms of how a single degree of 

freedom system would respond to that event. The horizontal 

axis shows the natural frequency of the system and the vertical 

axis shows the peak acceleration the system would undergo as a 

result of the impact event.  

To enable this function, select Tools>Post Processing Options. 

The Report & Post Processing Options screen will open.

Click Enable SRS Analysis to enable the tool. The user may vary 

the SRS Damping Factor (%) and the Point per Octave.

In the Events screen, the SRS analysis can be displayed as a table or as a graph. Select the preferred view and the 

analysis will appear on screen.
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SRS Table

SRS Graph
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DELTA V ANALYSIS (Δ V)

To enable this function, select Tools>Post Processing Options. The Report & Post Processing Options screen will open.

Click Enable Energy Analysis and/or Enable Energy Analysis in Event Table to enable the tool.  

Enable Energy Analysis displays the Δ V analysis for each event separately (Figure C).  

Enable Energy Analysis in Event Table displays the Δ V analysis for all events in the journey record (Figure D).

Click Δ V Level to enter the Pulse Width (seconds) and Pulse Amplitude (g) to be 

used for the analysis. These values are used to calculate the velocity threshold 

used in the Δ V analysis.  

FIGURE C

FIGURE D
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The table created for each event, is illustrated below: 

Time Sample (sec)– time at which the max peak of the individual event occurred 

T Shock (sec)– duration of the individual pulse 

Xmax, Ymax, Zmax (g) - maximum amplitude of the event

Emax (g) – maximum amplitude of a measurement made with an external accelerometer (legacy product)

Δ V – change in velocity; measured / calculated by the ShockLog.  

Eval – compares each pulse to the threshold derived when setting the Δ V levels and determines if the threshold 

was exceeded.

Note: Amplitude (g) is measured by the ShockLog; Δ t is based on the sample rate set by the user when the ShockLog was 
programmed. Δ V = 9.8g * Δ t.

When examining the data in the Event Table, the same information is available. However, the Δ V calculation is 

done using the modulus value of an impact.



74This document is written and published by ShockWatch, Inc. All rights reserved.

USER MANUAL

The following exercise will allow the user to practice the fundamental 

skills necessary to enter a basic setup, create a few impact events and 

view the downloaded data.

EXERCISE: DESK TOP TEST

CONNECTING THE SHOCKLOG TO A PC

SEND DEFAULT SETUP

COMMUNICATIONS WINDOW

The USB communication port is located on the right side of the ShockLog opposite the connector with the black 

cover. It is secured behind a threaded, protective cap that serves as the IP67 seal for the USB port. To access the 

USB port, carefully unscrew the protective cap and expose the USB connector.

Connect the USB cable to the ShockLog and then connect the other end to the PC USB port.

A default setup has been installed with the ShockLog software. This setup will be used for the purposes of this 

exercise. From the Communications window click “Send Setup” and a file selection window will appear. The system 

will automatically go to the appropriate directory, and the file default.setup413 will be listed.

Upon plugging in the ShockLog, you will notice that the Communications window will appear in front of the other 

windows. From this window you can communicate with the ShockLog unit and to monitor the current status.

If the Communications window is not already in the screen, from the “View” menu at the top of the screen, select 

“Communications.” A new “Communications” window will appear at the top of the screen. Position this dockable 

window as previously described. It is now possible to view the current status of the ShockLog in the various fields of 

the communication window.
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Select the default.setup413 file and click “Open.”

Select “Yes” when prompted with the question “Set the 

ShockLog unit’s clock to the current PC date and time?”

The information bar at the bottom of the screen will show 

a connecting status and change to “OK.” A confirmation 

window will appear after the setup has been successfully 

sent to the ShockLog unit.

After selecting “OK,” the Communications window will 

gray out for a few seconds and then will come back 

with several of the boxes completed. At this point, the 

ShockLog memory is being cleared and the unit is being 

reset for a new recording period. This process may take 

several minutes depending on the amount of data being 

cleared. Once completed, the status field will display 

“Running,” and the ShockLog can be disconnected from 

the PC.

DROP TEST
The ShockLog is now recording. The green Slot Alarm LED will flash every 5 seconds indicating that the ShockLog  

is recording.

Create a few events by dropping the unit on a desk. Ideally, drop the ShockLog onto a mouse pad or notepad. It 

should only be necessary to drop the ShockLog from approximately 25mm (1” inch) to create an 8 to 10 g impact event.

Repeat this process a number of times and have the unit land on different faces to create impacts in all three axes.
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DOWNLOAD THE DATA

VIEW FILE

After allowing the ShockLog to run for a short period of time and generating a number of events, reconnect the 

ShockLog to the PC via the USB cable. From the Communications window, it will be possible to view the status of 

the ShockLog and verify that a number of events have been recorded. In this case, 37 alarms were generated.

The ShockLog data file is now ready to be viewed. Click 

on either the file in the Explorer window or the Record 

Table window. The File Viewer screen will display the 

data from the desk drop test file that was just created.

Examine the data file by selecting the various screen 

options – Report, Setup, Slots, Slot Alarms, Summaries 

and Events.

Click the “Download” button on the Communications window and there 

is an option to enter comments regarding the journey/data that has been 

recorded. For this exercise, enter “Desk Top Drop” and click “OK.”

The status bar at the bottom left part of the screen will change from 

“Connecting” to “Data Transfer”; then a new separate window will 

indicate that the communication transfer is complete.

Click “OK” status and a new file will appear in the “Explorer” and 

“Records Table” windows.
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The ShockLog family of products allows for an efficient method of 

communication through an iButton interface. This interface allows 

users to perform basic ShockLog operations without a PC connection.  

iButtons are available to setup, start, stop, set clock and download the 

ShockLog report.

IBUTTON COMMUNICATIONS

The iButton interface serves as the link between iButtons and a PC.

The iButton Interface window is accessed via the “View” menu.  Within this window users are presented with three 

tabs: Read, Passwords and Program.

If the user is using an iButton originally set up for the legacy RD317 products, a warning will appear stating that the 

iButton is for an RD317 and asking “do you wish to change to RD317 mode?” By selecting “Yes”, the RD317 mode tick 

box will be completed and any programming of the iButton will be created in the RD317 compatibility mode.

If a new iButton is being set up, and it is desirable to use it with a legacy RD317 unit, it is necessary to select the 

RD317 Mode box before proceeding to ensure the iButton is setup correctly for use with the older products.

READ
Read is the first tab presented to users after opening 

the iButton interface. This screen is used to read what 

is on an attached iButton. The USB connector and BUS 

connector should be plugged into the PC USB port. It 

may be necessary to download drivers, but the download 

process is similar to the process described in the 

Software Installation section.

When an iButton is plugged into the connector bus, the 

software will display the type of iButton being read and 

whether there is data on the device.

To download data from a Download iButton, the user 

must click on the ‘”Download” button while the iButton  

is firmly in the connector bus.
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PASSWORDS

IBUTTON PASSWORDS

With iButtons and ShockLog units, there are two levels of password protection. The iButton password is the first 

level and is user definable. The ShockLog password is the second level and is factory set. The ShockLog password 

cannot be changed by the user.

The iButton passwords must be less than 8 characters and are set on the “Firmware Options” tab of the ShockLog 

Setup Window. The password needs to be entered into the password box and then repeated in the confirm box.  

Passwords are case sensitive and will accept alphanumeric values. However, symbols are not acceptable characters.

When a ShockLog is programmed with an iButton password, all iButtons used  

with that ShockLog unit must be programmed with the same password,  

otherwise the ShockLog unit will ignore the command. To program an iButton  

with the appropriate password, the iButton must be connected to the PC via  

the USB connection BUS and then the Password tab selected.

Move to the Password box and enter the password exactly the same as the setup  

file. Move to the confirm box using either the Tab key or moving the mouse to  

the box. Re-enter the password to confirm.

Once the password has been set, it is necessary to reprogram the iButtons by following the instructions in the 

“Program” section below.
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SHOCKLOG PASSWORDS

PROGRAM

The ShockLog Passwords are factory defined and cannot be changed by the user. The ShockLog passwords work 

in a similar way to the iButton passwords, preventing communication with the ShockLog from iButtons that do not 

have the appropriate passwords. However, the ShockLog passwords are unique to each ShockLog and are supplied 

with the units when purchased. These passwords provide a unique number for every ShockLog preventing generic 

passwords from being set up and used on all units.

Every unit shipped from the factory has 3 passwords supplied with it: Level 1, Level 2 and Level 3. The ShockLog 

password used here requires the Level 2 password.

In order to activate the passwords in the ShockLog unit, the user must follow the instructions in “Setup 

Passwords” later in this manual. Once these passwords have been activated, the only iButtons that will 

communicate with the ShockLog unit are those programmed with the same ShockLog Level 2 password.

To program an iButton with the appropriate password, place it into the USB connector BUS attached to the PC 

and open the iButton interface. Select the Passwords tab and enter the ShockLog password into the Password box 

under the ShockLog section. Re-enter the password in the confirm box and then go to the Program tab and follow 

the instructions as detailed later in this manual.

With an iButton attached to the USB Connection BUS, when entering the  

“Program” tab, the user will be presented with two check boxes for the  

different passwords available and five buttons that are either grayed out  

or live, depending upon the iButton that is attached.

The buttons allow for the creation of: Start, Stop, Setup, Clock and  

Download iButtons. A number of the iButtons utilized by the ShockLog  

can be programmed for a number of different options providing the  

user with more flexibility in their stock of iButtons.

If an iButton is to be set with a password, it is necessary to click on either  

the iButton or ShockLog password box at the top of the tab. This action  

will take the user back to the Password tab, where the passwords must be entered or created. For instructions, 

refer to the “Password” section earlier in the manual.

Once the passwords have been set, click on the appropriate program button to send the program into the iButton. 

“Finished” will appear when the programming is complete. If the user is sending a setup to the iButton, when the 

setup button is selected, the user will be presented with the file search window and will be asked to select the
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desired setup file. Please note that if passwords are required, they must have been setup within the setup file 

before sending to the iButton. Refer to the File Setup section earlier in this manual.

SETUP PASSWORDS
ShockLog passwords allow users to protect their units from unauthorized access, download and corruption. The

ShockLog passwords are factory defined for every ShockLog and are unique to each ShockLog serial number.

To set the passwords within a ShockLog, activate the “Setup Passwords” key on the Communications window. Go 

to the View menu and select the “Password Setup” button. The “Password Setup” button will now be available in 

the Communications window.

Attach the ShockLog to the PC, click on the “Password Setup” button in the Communications window and a new 

window will open. Enter the 8 digit numeric code (provided with the ShockLog), click “Enable Passwords” and  

then “OK.”

The Status bar will show that the system is connecting to the ShockLog and will return “OK.” The ShockLog is now 

password protected.

Now, when a user attempts to communicate with the ShockLog, it will be necessary to enter an appropriate level 

password to gain access. A window requesting the required level of password will be displayed. The following 

levels are required: 

Stop   Level 1

Start   Level 1

Download  Level 2

Send Setup  Level 2

Set Clock  Level 1

Read Setup  Level 2

Note: The ShockLog program has been set up to memorize a password while in the same session with the same ShockLog 
attached. Once a password has been entered, it will not need to be re-entered until a new ShockLog session is opened.

To remove the password from a ShockLog unit, attach the ShockLog to the PC and open the Communication 

window. Click on the Setup Password button and enter the Level 2 password but this time select “OK” when the 

“Enable Passwords” button has not been selected. The password settings will be removed from the ShockLog.
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The Security Log provides users with a detailed list of communication 

activity for the ShockLog unit. This data includes dates and times of 

activities, a description of the activity and provides an additional audit 

trail for a data file. The ShockLog Security Log can only be cleared 

by the factory during the ShockLog calibration process. For security 

reasons, users cannot clear this file.

SECURITY LOG

To view and export the ShockLog security log, it is necessary to activate the “Security Log” key on the 

communications window. Go to the View menu and select the Security Log Button. Return to the Communications 

window and the Security Log button will be available.

After the Security Log button has been activated and a ShockLog unit is attached to the PC, clicking on the button 

will bring up the following grid of information:

The Grid provides the following data columns:

Rec’ No  Sequential number given to every activity recorded. 

Date & Time Provides the specific date and time the activity occurred. 

Entry  Provides a description of the activity recorded.

Data  Shows the size of the data recorded.

The grid can be sorted by column by clicking on the top of any of the columns. The data will be sorted by the 

selected column. By sorting on the “Rec’ No” column, the data will return to the original order.

The Security Log data can be exported into a comma delimited file (*.csv) for importing into other applications 

such as Microsoft Excel or Word. To Export the file, click the “Export” button at the bottom right hand side of the 

grid. A file save window will appear. Amend the file name as required and select a different directory as required 

from the drop down selection at the top of the screen.

Click the “Save” button and the file will automatically save as a .csv file for importing into other applications.
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It is possible for users to export batches of data files as well as individual files via the records table.

Within the records table, by highlighting an individual record and then pressing the right hand mouse button you 

will be presented with a small menu with the option of “Export to Database.” This will open a standard Windows 

Save window, and the user is able to create a new database to save the selected data file.

If more than one file is to be exported, the user is able to either click on the first required file and hold down the 

left hand mouse button while dragging down to the last required file, or click on the first file, press and hold the 

shift key and click again on the last data file required. Once the range is highlighted, a right hand mouse click will 

return the menu allowing for the export to database function to be used.

In manual section various tools and techniques available for users to manipulate the data file database will be 

overviewed. These tools and techniques allow the user to find and analyze data as quickly and efficiently as 

possible. The various tables of data will be reviewed and the different options available for each display will be 

explored.

MULTIPLE FILE EXPORT

DATABASE MANIPULATION

EXPLORER WINDOW
The Explorer window displays the available data files within the database. The system utilizes a ‘Windows Tree’ 

format to enable users to quickly search through the files.

The file name format is in keeping with the legacy file names and provides the date and time of download along 

with the serial number of the ShockLog unit used for monitoring.

Click on a given file and the File Viewer will display the Report tab for the selected file. The Explorer window will open 

the file showing the number of events, number of summary records and number of slot periods within the data file.

The events can be further expanded to show each individual event as separate entries. In the Event tab, with the 

events listed individually it is possible to quickly change between the individual events by double clicking upon the 

event number.

While in any of the tabs, it is possible to view a number of events together. Click in the box to the left of each 

event number (will enter a check and change the background to yellow). Initially only the last event selected will 
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be displayed on the main viewer screen. The headers have changed slightly and no longer display the various tab 

options. This is because additional windows are opened for each of the events checked.

Now that the events are opened, it is possible to restructure the screen view using the cascade and tile options 

under the View menu. This option will be detailed later in the manual.

Each individual event can now be used as in the Events tab, with full zoom capability and the cursor bar to provide 

additional data. The additional text information is not available on the right hand side of the screen but g value 

information and the number of milliseconds at the cursor point are displayed in the bottom left hand corner of  

the screen.

RECORDS TABLE
The Records table provides an alternative file selection to the Explorer window. The advantage of the Records 

Table over the Explorer window is that the user is able to sort and re-order the data files within the Records Table 

making it a powerful search tool.

COLUMN DATA

The Records Table is constructed in a tabular format with various columns of data for each of the data files within 

the database. The main columns are as follows:

Download Date: Provides the date and time that the data file was downloaded into the database.

User Comment: When downloading a file, users are offered the opportunity to enter a comment; this comment will be 
displayed in this column, up to a maximum of 15 characters.

Model: Displays the type of ShockLog used to record the data file.

Serial No: Displays the serial number of the ShockLog device.

Events: Provides the total number of events recorded within the data file (Warn & Alarm added together).

Warns: Shows the number of Warning events.

Alarms: Shows the number of Alarm events.

Summaries: Displays the number of summary periods recorded during the data file.

Slots: Shows the number of Slot periods recorded during the data file.

To move around the Records table, the user can move up and down by either the center wheel on a mouse (if 

available) or by using the scroll bar on the right-hand side. When the Records table is in a landscape view there will 

be no need for a scroll bar to move left and right as all columns will be visible. However, should the user decide 

to dock the Records table in a portrait position, a scroll bar at the bottom of the table will be presented and will 

enable the user to move left and right through the columns.
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FILE SORTING

In the Record Table, it is possible to change the order of the display by any of the columns, enabling the user 

to search for specific sections of data. By clicking on the title of a column, the database will be sorted by the 

information held within that column. By clicking the column again, it is possible to change between the ascending 

and descending views of the data.

For example, if a user is interested in knowing all of the files downloaded from a ShockLog with a specific serial 

number, click on the title of the Serial Number column to put all of the files into serial number order.  All data files 

from the same serial number will be displayed together.

Likewise, if the highest number of events is of interest, it is possible to sort the database via the events column and 

quickly identify the files with the highest number of events.

In order to return the database to its original setting, sort the files via the Download Date Time column and the 

data will return to date order.

HYPERLINK TO ADDITIONAL INFORMATION

From the Records table it is possible to hyperlink to any of the data files being viewed. Double click on the 

Download Date Time column on the desired file. This action will open the selected file in the Report tab view.

To change files, double click on a different file and the system will change files. Whatever view the user is in when 

a file is selected, the Report tab view will be opened.

COLUMN DATA

The Event Table is constructed in a tabular format with various columns of data for each of the data files within the 

database. The main columns are as follows:

Show Slots: A hyperlink button to the time slot data associated with the event.

Number: The event number that represents the order the event data has been recorded in. Please note that the first event 
of any ShockLog data file is 0 (zero) and not 1 (one).

EVENT TABLE
The Event Table displays all of the events, both Warning and Alarm, from a selected data file. The table provides 

details of an individual event and allows the user to sort the information to identify information such as the most 

significant event in terms of shock or the modulus value. In addition, the table provides a number of hyperlinks 

directly to other related sections of data.
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Event Date: Displays the date and time the specific event was recorded; relates to the ShockLog internal date and time and 
may vary with the PC date settings if the unit was set up in another time zone.

Duration: Shows the length of time in seconds that the event lasted and can be 1, 2, 4, 8, 16, 32, 64, or 128 seconds.

Range: Displays the g range that the ShockLog was set to when recording the event.

Rate: The effective sample rate that the ShockLog recorded the event at and will be dependent upon the compression 
selection made by a user when setting up the ShockLog unit. All events are sampled at 4,096 samples per second. However, 
depending upon the compression required and the user selections made the recorded sample rate may be lower.

Temp.: The temperature recorded via the internal thermistor at the time of the event.

Max X, Y & Z: These columns show the maximum g value seen on each of the axes during the recorded event.

Modulus: The Event Modulus which is the vectored X, Y and Z data, calculated with the following formula: Modulus = 
Sqr(XSample ^ 2 + YSample ^ 2 + ZSample ^ 2).

To move around the Event table, the user can move up and down with either the center wheel on a mouse (if 

available) or by using the scroll bar on the right side. When the Event table is in a landscape view there is no need 

for a scroll bar to move left and right as all columns will be visible. However, should the user dock the Event table 

in a portrait position, a scroll bar at the bottom of the table will make it possible to move left and right through 

the columns.

FILE SORTING

In the Event Table, the user has the capability of changing the order of the display by any of the columns, making it 

possible to search for specific sections of data. Click on the title of a column and the database will be sorted by the 

information held within that column. Click the column again and it is possible to change between ascending and 

descending views of the data.

For example, if interested in knowing all the events within the data file with high modulus values, click on the title 

of the Modulus column to put all of the events into modulus value order. Likewise, if interested in the highest g 

value on Y axis, it is possible to sort the database via the Max Y column and quickly identify the events with the 

highest g value for the Y axis in the events.

To return the database back to its original setting, it is necessary to sort the files via the Number column and the

database will be back to event number order.

HYPERLINK TO ADDITIONAL INFORMATION

From the Event Table it is possible to hyperlink to the Slot graphs and the event graphs for individual events. The 

Show Slots column has a button to click upon for each event. By clicking on this button the main File Viewer screen 

will move to the appropriate section of the slot graphs, zoomed into the section that relates to the event time period.
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If the user now wishes to view the event curve for this specific event, there is a choice of linking straight to it from 

the Slots tab or from within the Event Table. From the Event table, it is possible to hyperlink by double clicking any 

of the Number column, the Event date or the graphic next to the date.

By clicking on any of these options the user will go to the selected event curve within the Events tab and will be 

able to interrogate the event curve as explained earlier in this manual.

It is possible to continue clicking on different events and the File viewer will continue to update the event curve as 

the user works through the events from the Event Table. Additionally, once in the Event tab, it is possible to scroll 

through the events using the arrows in the top right corner.
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NEW

The “New” option in the File Menu allows users to create a new database. This feature is used for various reasons 

including the creation of archive databases, creating unique databases for different companies or departments 

etc. By clicking on the option, the user will be presented with a save file window. Enter the desired name into the 

‘File Name’ box at the bottom of the window. Ensure the file is being saved in the correct directory, which can be 

selected via the drop-down window at the top of the screen.

While viewing a database, it is possible to identify the current database by the name presented in the information 

bar at the top of the screen. In addition to the Database name, you will also be presented with the data file name 

currently opened for viewing.

OPEN

The “Open” option from the file menu provides the user with the ability to open different databases that have been  

created. Users can open archive databases or different databases for different parts of the company / organization.

Click “Open” in the menu, the user will be presented with a file ‘Open’ window and will default to the ShockLog 

directory created for storing ShockLog databases.

When the desired database has been found, click the appropriate file name and then click “Open.” The ShockLog 

software will appear to close but will automatically reopen, this time with the selected database opened. The 

name in the header bar will now show the new database name. To change back, follow the above procedure and 

select the default database “ShockLog.” Databases from different directories can be selected and the ‘Look in’ 

drop down menu can be used to search different directories as required.

IMPORT

The “Import” function under the file menu allows users to import data files into the current database. Generally, this 

feature will be used to import legacy ShockLog data files that a user may have recorded on their system and wishes 

to view under the new software package.

FILE MENU

In this manual section all of the available menu options and features 

that have not already been discussed will be covered.

MENU OPTIONS
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The download process of ShockLog products will automatically import the data files into the opened database and 

will not require the import option. However, should a problem occur with the automatic importation of data files 

following a download from the latest ShockLog ranges, it is possible to import the data file through this method.

To import a single data file, select the “Import” option from the file menu. The ShockLog Data directory will open 

and show a list of data files. The system default will display data files from the latest generation of ShockLog units 

ending with .sl_sdr. To select one of these files, click on the desired file and then click “Open”. The system will take 

a few seconds and the file will appear at the bottom of the Explorer window and in the Records Table.

If the user wants to import legacy data files, it is necessary to change the “Files of Type” to .sl_data, which 

represents older legacy data files. Once the desired file has been selected, click “Open”.  For more details, refer to 

Importing Legacy Data Files section

Should the user wish to select a number of files at the same time, i.e. a complete directory of legacy files, this is 

possible within the same menu option. Go into the “Import” menu option and select the file type (new or old), 

click on the first file, then if it is a list of files, all in order, press and hold the ‘Shift’ key on the keyboard and then 

click (with the mouse) on the last required file. The whole selection is highlighted. If this is all of the desired files, 

click “Open” and all of the selected files will be imported. Please note this procedure may take a couple minutes 

for the computer to complete the importation depending upon how many files are being imported.

If the desired files are not listed all together, it is possible to select any group of files using the Alt key on the 

keyboard. Click on the first of the data files, press and hold the Alt key, with the mouse proceed to click on all of 

the desired data files, one at a time, until all of the files have been selected. Once all files have been selected, 

release the Alt key and click on the Open button with the mouse. All of the files will now be imported. The process 

can take several minutes depending upon the number of files being imported.

EXPORT

The Export function has been covered in the individual sections of Slots, Summaries and Events. The Export option 

under the file menu works in a very similar style but instead of focusing on one section of a data file it focuses on 

the option to export the complete data file or selection of data files. It should be noted though that this export 

facility can also be focused down to exporting a small section of a data file just as if it had been entered from the 

Slots, Summaries or Events.

The data file being viewed from the Explorer window will be highlighted as the main option.  However, no data will 

be selected for export.

On the left side of the Export window an Explorer tree style display will appear. The user will have an option of “All 

records (x)” with X being the number of files in the database, or the long description of the data file currently being 

viewed.  On the right side a number of tools to narrow down the export criteria are available.



89This document is written and published by ShockWatch, Inc. All rights reserved.

USER MANUAL

A number of options are available for downloading all of the files (or some of the files) within the database. Click in 

the tick box next to the “All records” entry on the left side. The box to the right will be filled with a list of the data 

that is to be exported with ticks to the side, which will include:

• Download Data 

• Warns 

• User Comment 

• Alarms Model 

• Summaries 

• Serial no 

• Slots Events

If the user does not want to export any of this data, click the tick to blank the selection box. To highlight all of the 

boxes again, click on the “All Data” button and all of the ticks will be filled in again.

There are two slide bars on the right-hand side of the screen. When exporting all records, these will represent 

the data files within the database.  The user can move these bars left and right to select the range of files to be 

exported right down to an individual data file.  Once the user has selected the data required and the data files for 

the information to be extracted from, click “Export”.

The system will display a “Browse for Folder” window that allows the user to select the desired export location for 

the file. Select the directory where the export is to be stored and press “OK”. Alternatively, it is possible to create 

a new directory for the export file by selecting “Make New Folder”. Upon pressing this button, the system will 

create a new folder under the current directory and name it “New Folder”. To change the name, right click on the 

new folder and select “Rename”. Type the new name, press return, and save the export file to the new directory.

The Export will create separate comma delimited files for the different sections of data being exported. These files 

can be opened in such programs as Microsoft Excel and the data can be used to further analyze the journey or 

storage period.

DELETE

The “Delete” option under the File menu allows users to remove data files from the database and must be used with 

extreme caution.

To remove a file, select it from the Explorer Window, go to the file menu, and select ‘Delete’

The following window on the right will appear warning the user that a complete data file is about to be removed from 

the database.  Click “OK”, the file will be deleted, and the user will be returned to the Explorer Window.
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PRINT

The printing options under the File Menu consist of 4 sections and provide the following functionality:

Print – Prints to the default (or selected) printer and will print the current view within the file viewer screen 

depending on the current tab being viewed.

Report – Will generate the one-page report, giving users a summary of the slots and events seen in a given 

recording period.

Slots – Will print the Slot graphs and will create a page for each of the slot graphs currently being viewed in the 

slot tab.

Summary – Generates a selection window, providing the user with the ability to select the columns of data of 

interest (in Summary Tab).  Additionally, users can insert a custom report title that will be printed on the top left 

side of the report.

Events – Generates a print out of the event currently being viewed (in Event Tab).

Print Screen – Sends the whole ShockLog software screen currently being viewed to the printer. It will include the 

Explorer window, Records Table, Events table and any other window currently being displayed on the ShockLog 

software screen.

Print Setup – Opens the Microsoft Printer selection and setup window, which can be used in the same manner as 

any Microsoft windows package.

Print Preview – Allows users to view what is going to be printed before committing it to paper. When selecting 

this option, the user will be presented with the Microsoft Printer selection and set-up window. Selecting print from 

this window will display the print document on the screen and offer the users the ability to print the document.

GRAPH / UNIT OPTIONS

This window provides users with several options including customizing the color settings for the graphs and 

changing the units of measure being displayed. To change the color settings for a given graph parameter, click on 

the desired parameter button, i.e. ‘Max Pk X’, and an additional window showing a color pallet will be presented. 

The user has the choice of selecting any of the standard colors displayed on the front or creating a custom color by 

selecting the “Define Customer Colors” button and defining the desired color.

The units of measure to be displayed can be changed with the options on the right side of the window.

Acceleration  Defined as g, m/s2 or ft/s2

Pressure  Displayed as bar or lb/sq in. 

TOOLS MENU
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Temperature  Displayed as Celsius or Fahrenheit. 

Velocity  Displayed as cm/s, m/s, ft/s or in/s.

Additional options can be selected by checking the following checkboxes:

Limit Software Filtering  

Relates to the post processing filters on the Event graphs. When this box is checked and the data file being viewed 

has a frequency filter of less than 250Hz, this feature will limit the filtering options to the filter value set in the 

settings. For example, if the settings file had a frequency filter setting of 90Hz, the highest filter setting available 

for post filtering will be 90Hz.  If this option is not checked then the filter options available will be 250Hz and 

lower.  The default setting is to have this option selected.

No Range Bars 

Relates to how the event graphs will be displayed when the events have not been recorded at 4,096 samples per 

second. If this option is selected it will present the graph as a smooth line, taking the mean values between the min 

and max values of the compressed data. If it is not checked the user will see the range bars, i.e. the range between 

the max and min values in each group of compressed data. This option must be selected for every journey.

English 

Select if English language it so be used

Unicode CSV    

Select if the data exported is in Unicode CSV or ASCII

DATA PATHS

COMMUNICATION PORT

The Data Paths option displays the directory routes that are currently set for the XML, Setup Files and Data files. 

The XML files are configuration files for the ShockLog accessories and should not be touched by users unless 

instructed to do so by the ShockLog Technical Support team. The Setup and Data files path show the default 

settings of where these will be stored and any changes that are made here will change the directories where such 

files will be stored and searched for future use. Any changes within this section should be made with extreme 

caution and advice should be taken from the ShockLog Technical Support Team prior to making such changes.

The selection of communication ports is generally only required when using serial communication and the system 

is unable to automatically select the correct serial connection. Users are able to select from the drop-down menu 

the appropriate port being utilized. To find the correct port being used by the computer, users must check under 

the device manager within the computer control settings. Contact IT if it is unclear how to proceed.
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With this option, users are also able to select the baud rate at which the ShockLog will communicate. There are 

times when a slower baud rate may be required. If the user is experiencing communication difficulties, slowing the 

baud rate may resolve the problem.

COMPACT AND REPAIR DATABASE

Compacts and repairs corrupted databases.

EXPORT CURRENT RECORD AS A DATABASE

Exports the currently selected record as an Access database.

RESTORE DEFAULT SETTINGS

Restore Default Settings will restore the ShockLog to settings when it was first installed. Any custom settings and 

directory paths that the user has set will be removed. When selecting this option, the user will be presented with a 

warning that all current settings will be lost. If “YES” is selected, the default settings will be set. It is not be possible 

to revert back to custom settings after restoring default settings. Please use extreme caution with this option.

UNIT RADIO SETUP

Unit Radio Setup is used to program an individual ShockLog unit with the correct network name/address for the RF 

Base unit. The settings are the factory defaults and the same as the standard settings of the RF Base unit.

If the user has more than one network or just wanted to change the name for security reasons, it is possible to 

program the RF base from the “Radio” window by selecting the “Base Station” button and creating a specific 

name. In order to program the individual ShockLog recorders the user would need to use this option and enter the 

same details as on the RF Base. Once the user has set up the desired names, the information must be sent using

SAVE CURRENT SETTINGS 

This feature allows users to save the screen settings with their own preferred layout. Once a user is happy with 

where they have the different tables and screens docked, they are able to save these settings so that if another 

user moves things, they are able to restore their preferred settings.

RESTORE SAVED SETTINGS

If a user has saved their preferred settings and they should get moved up, by clicking on this option all settings will 

be returned to the last saved settings.
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Opening the View menu presents the user with a list of different screens, sections and buttons that can be 

activated or deactivated in the ShockLog software.

Status Bar: Shown at the bottom of the screen; contains information in relation to a connected ShockLog unit. By 

default, the status bar will be visible but can be switched off through the use of this option

iButton Interface: Opens a new window allowing users to interface with the iButton options. This function is fully 

described earlier in this manual.

Setup: Opens a new window allowing the user to create or modify ShockLog setup files. This function is fully 

described earlier in this manual.

Communications: Opens a new “dockable” window that allows users to communicate with an attached ShockLog 

device. This function is fully described earlier in this manual.

Password Setup Button: Enables or disables the Password button on the Communications window.

Security Log Button: Enables or disables the Security log button on the Communications window.

View Read Setup: Allows the user to view the current setup.

Processed Data: Removes known anomalies from the data being viewed.

The Windows menu allows the user to open and arrange various viewing screens to maximize the available data.

the “Setup” button in the Communications window. The ShockLog unit must be connected to the PC via the USB 

for this setup.

READ LAST GPS DATA

When a ShockLog 298 unit with the GPS module installed is attached, it is possible to request the last positional 

information recorded. This feature will indicate where or not the antenna is in view of the satellites.

CREATE EDIT USER SETUP LIST

Allows the user to edit and delete setup files created for the ShockLog.

VIEW MENU

WINDOWS MENU
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By hovering over the New Window option, an additional menu appears to the right side listing a number of 

different screens and tables that are available.

The Explorer, Record Table, Events Table, Slot Breaks Grid, and Radio Table and are all dockable windows and are 

explained in detail earlier in this manual. 

Tile Vertical and Tile Horizontal options are used to rearrange the file viewer screens when more than one is being 

used at the same time. For example, if a user selects several events to be viewed at the same time, it is possible 

to have these displayed in different ways.  The user can have the events tiled on the screen so that all the graphs 

can be seen at once. It should be noted that if the user tries to view more than four graphs at once, it is difficult to 

view them in a tile view is likely the better option.

The Close All option will close all screens currently open within the file viewer area except for the main file viewer 

screen with the Report, Slots, Summary and Event tabs. This feature is a very useful tool if many event graphs have 

been viewed at the same time. 

The Help menu contains the ‘About’ option that will provide details as to the current version installed.  Here, users 

can also select if they’d like to automatically check for software updates.

HELP MENU
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In order to convert the legacy data files, it is necessary to import them into the 

database. Under the File menu select the “Import” option.

If the data file has been downloaded using the latest software, the correct directory will appear, and it will only be 

necessary to change the file type to view the old-style data files.

Select (*_sl_data).

A list of available data files will be displayed. Highlight the desired file and click “Open”.  After a few seconds the 

file will appear at the bottom of the Explorer Table window.

If it is necessary to import data files that have already been downloaded with the old ShockLog software, change 

the data directory to that of the old software data directory.

Highlight the required data file and click “Open”.

If there are a number of data files to be imported, follow the process as described above, but instead of selecting 

a single file, find the first file in the list, click on the file, hold the shift key and click on the last file of interest then 

release the shift key. A range of files will be highlighted and by clicking the “Open” button, all the files will be 

imported. This operation can take several minutes, and the software will appear to be doing nothing until the files 

begin to appear in the Explorer Table.

It is also possible to select a number of specific files using the control key to highlight the required files from 

within the list. Clicking the “Open” button once the desired files have been highlighted will import the files.

A file selection window will appear.

IMPORT OF LEGACY DATA FILES
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POWERING THE SHOCKLOG SATELLITE

DESCRIPTION & FEATURES
The ShockLog Satellite Impact Recording and Tracking System combines the ShockLog 298 impact recorder and a
satellite communication module to deliver outstanding impact recording, real-time reporting and asset location.
Real-time reporting of impact alerts informs the right people when unacceptable conditions have occurred during  
a journey.

All required lithium batteries for the ShockLog and ShockLog Satellite module are installed at the factory unless 
otherwise arranged with SpotSee. Batteries included are as follows:

CAUTION - RISK OF EXPLOSION IF BATTERIES 

ARE REPLACED BY AN INCORRECT TYPE. 

DISPOSE OF USED BATTERIES ACCORDING  

TO THE INSTRUCTIONS.

Component Battery Type Quantity

ShockLog 3.6V AA Lithium Batteries 2

Interface Board 3.6V AA Lithium Battery 1

ShockLog Satellite Module (Internal) 1.5V AA Lithium Batteries 4

ShockLog Satellite Module (External) 3.6V C Lithium Batteries 4

NOTE: Operating the ShockLog Satellite in a location without line of sight to the sky will significantly reduce the 
battery life of the satellite module.
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CONNECTING THE SHOCKLOG 
RECORDER TO THE SATELLITE MODULE
The ShockLog Satellite satellite module and the ShockLog must be connected prior to use. A plug on the satellite 
module covers the communication port between the module  
and the ShockLog.

Prior to use, the satellite module will show OFF on the end of the module.  

Unscrew the plug and remove. 

Connect the black connector / cable to the communication port of the satellite module.

Keep the plug in a safe place as it will be used to turn the device off when not in use.

MOUNTING
IMPORTANT: When mounting the ShockLog Satellite hardware, care must be taken to allow for line of sight to 
the sky. Failure to do so will result in compromised satellite communication.  

It is recommended that you mount the unit prior to starting it. This action prevents any impacts being recorded 
that are a result of the mounting process.  

Find a suitable mounting location on the asset with line of sight to the sky.

The ShockLog Satellite has x, y, and z axes noted on the unit. If the mounting of the ShockLog Satellite does not 
allow you to match the axes of the unit, it is advisable to make a note of the exact mounting in order to correctly 
analyze the reported impact values.  

The ShockLog Satellite uses magnets for mounting. Grasp the unit in the positions noted by “Hold Here.”  Position 
two magnets in place and then carefully roll the last two magnets into position.  

Magnetic mounts are intended for temporary mounting.



100

APPENDIX A - SHOCKLOG SATELLITE

This document is written and published by ShockWatch, Inc. All rights reserved.

SAFETY WARNING

START MONITORING
Once the ShockLog has been programmed and the ShockLog Satellite unit has been mounted, the unit must be 
started to begin recording.  

It is recommended that the START iButton be used to start the ShockLog Satellite. Remove  
the black center cap from the ShockLog iButton port and insert the START iButton into the 
port. When the iButton LED on the ShockLog is red and the Slot Alarm LED is green, 
remove the iButton. The unit will start in one minute.  

The ShockLog could also have been preprogrammed to start at a specific time. Refer to Configure the ShockLog 
Satellite / ShockLog section of this manual for details.

Close the lid of the ShockLog Satellite system and secure the latches. 

When an impact event occurs during the journey, an alert will 
be sent through the web-hosted application and the ShockLog 
LED Event Alarm will flash red every five (5) seconds for an 
alarm condition and every ten (10) seconds for a warning condition.

STOPPING THE SHOCKLOG SATELLITE
The ShockLog Satellite can be stopped with the Stop ibutton or it can be stopped after connecting the ShockLog to 
a USB port. To prevent capturing impact events resulting from dismounting the ShockLog Satellite, a best practice is 
to use the Stop ibutton.  

Open the ShockLog Satellite case, remove the black plug from  
the ibutton port.  

Insert the STOP ibutton into the ibutton port.  

All three LEDs will flash red every ten (10) seconds when 
the unit has been stopped.
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DOWNLOADING THE SHOCKLOG 
SATELLITE
When the ShockLog Satellite system’s journey has ended, the full dataset from the ShockLog can be downloaded 
through the USB port. This step is recommended if impact data needs additional analysis.

RECOMMENDED STORAGE
When the unit is not in use, it is recommended that the ShockLog be stopped and the satellite module be turned off.  

To turn off the satellite module, locate the satellite module in the ShockLog Satellite box and disconnect the 
connector/cable.   

Locate the plug and insert it into the connector such that the word OFF is visible. NOTE If the word ON is visible, you 
will be powering the module and draining the battery

REDEPLOYING THE SHOCKLOG 
SATELLITE
When the ShockLog Satellite is ready for another journey, the ShockLog should be reprogrammed for the new 
journey.  When a new setup is sent to the ShockLog, all existing data is deleted from the device. Refer to Creating a 
Setup section for instructions on creating a new setup.
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DESCRIPTION & FEATURES

POWERING THE SHOCKLOG CELLULAR 
MODULE 

CONNECTING THE SHOCKLOG 
CELLULAR MODULE 

The ShockLog Cellular Impact Recording & Tracking System combines the ShockLog 298 impact recorder and a 
cellular communication module to deliver impact recording, real-time reporting of event/alarm conditions and 
asset location.  

The ShockLog Cellular Module may be used with any ShockLog 298 Impact Recorder with firmware revision 30  
or greater.

All the required lithium batteries for the ShockLog Cellular are provided unless otherwise arranged with SpotSee.  
To install the batteries, please follow the instructions below:

Unscrew the Battery Panel (see image to the right).   
Note:  A Phillips screwdriver is required to complete this step.

Install the six (6) AA batteries provided in the direction noted in each 
battery slot, verify that the gasket is in place and replace the battery 
panel making sure that the certification label is visible. Tighten the 
screws on the battery panel to preserve IP 67 rating.

The ShockLog Cellular module and the ShockLog 298 must be 
connected prior to use. Attach the Hirschman connector on 
the cellular module to the Hirschman plug on the ShockLog 298.
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MOUNTING THE SHOCKLOG CELLULAR 
MODULE 
Important: The ShockLog Cellular does not require line of site for any communication. However, it must be 
able to receive cellular signals. If mounting in a container, ensure that any metal content of the container does 
not block cellular reception.  
Rule of thumb: If a cell phone works where the ShockLog Cellular is mounted, the device will communicate. 
 
The ShockLog 298 and ShockLog Cellular may be mounted to the mounting plate included with the ShockLog 
Cellular. The mounting plate may be attached to the shipment with mounting bolts or magnetic feet (included).  
Avoid metal to metal contact when mounting the ShockLog.

It is recommended that you mount the unit prior to starting the ShockLog. This action prevents impacts resulting 
from the mounting process from being recorded.

START MONITORING
Once the ShockLog Cellular has been mounted, the unit must be started to begin recording.

If the start date has been preprogrammed, there is no additional action required of the user. 

To start recording immediately, it is  recommended that the START iButton be used to start the ShockLog. 
Remove the black center cap from the ShockLog iButton port and insert the START iButton into the port. When 
the iButton LED on the ShockLog is red and the Slot Alarm LED is green, remove the iButton. The unit will start in 
one minute.

When an impact event occurs during the journey, an alert will be sent through the web-hosted application and 
the ShockLog.

LED Event Alarm will flash red every five (5) seconds for an alarm condition and every ten (10) seconds for a 
warning condition.
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STOPPING THE SHOCKLOG
The ShockLog can be stopped with the Stop ibutton or it can be stopped after connecting the ShockLog to a USB 
port. To prevent capturing impact events resulting from dismounting the ShockLog Cellular, a best practice is to 
use the Stop ibutton.

Remove the black plug from the ibutton port.

Insert the STOP ibutton into the ibutton port.

All three LEDs will flash red every ten (10) seconds when the unit has been stopped.
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ACTIVATING THE SHOCKLOG 
SATELLITE/CELLULAR

Enter the admin email address in the pop-up box and click Enter  

An email will be sent to the Admin’s email address from no-reply@shockwatch.com.  

NOTE: If the email is not received within 5 minutes, please check your spam or junk folders. If it has still not been 

received, please contact SpotSee technical support.

Follow the link in the email to create your password. 

Enter the Customer Number found on the packing list that shipped with the ShockLog 
Satellite, the SpotSee invoice or order acknowledgement.

Enter the Unit ID found on the label on the ShockLog Satellite.  

Accept the Terms and Conditions.

Click Activate.

Once the administrative account is established, 
navigate to cloud.spotsee.io and log in with the 
Admin email and password.

A message will prompt you to  
select an available contract for  
the unit. Click the dropdown  
list to select a contract.  
Click Activate.  

Important: Activation of the satellite module can take up to 2 business days. The cellular module will become 
active approximately 15 minutes after activation. 

If this is the first connected device purchase for your company, you must establish an account admin. This person 
will be responsible for managing user access to the SpotSee Cloud.  

Navigate to activate.spotsee.io to begin the activation process.
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The admin can view and manage other users and assets inside the company.  Clicking Users on the left side menu 
displays a list of all existing users for your account.  

Add a user by clicking the plus (+) sign or edit a user by clicking the pencil icon.

Jane Smith

John Brown

Jane

jsmith@email.com

Smith
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LOGIN AND PASSWORD RECOVERY
Navigate to cloud.spotsee.io and enter your email and password. 

If you have forgotten your password, click “Forgot Password.” Enter your email and click “Reset Password.”  

An email will be sent with directions and a link to reset your password. 
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DASHBOARD
The SpotSee Cloud allows you to monitor the ShockLog Satellite from any location. After logging into the cloud 
platform, the dashboard will show you the last known location of your ShockLog Satellite assets, a list of your active 
assets and the most recent alarm for each asset.

To examine the information for each individual ShockLog Satellite unit, click on the asset name in either the Active 
Asset or Last Alarm Per Unit lists or click on the location icon on the map. 

If multiple active assets are positioned in the same location, the 
number of units in that location will be displayed.
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ASSET PAGE

DATE RANGE

Once a ShockLog Satellite unit has been selected, more detailed information surrounding that unit will be displayed. 

By default, the date range for a device in the SpotSee Cloud is the past seven (7) days. The date range is shown in the 
top right portion of the screen. If a particular date range is of 
interest, the range can be changed by selecting the calendar
icon shown to the right.

Clicking the calendar icon will open up a window where the user can set the date range as desired. Click the clock 
icon, and a calendar will open for the user to select the date. Click Done when the date range has been set. Click 
Update to set the date range.  

The data from that particular date range will be in the dashboard view.  

NOTE:  When large amounts of data are 
being loaded, it will take a few minutes 
for the data to render.
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NOTIFICATIONS

LOCATION

When an alarm occurs, notifications can be sent to interested users. Click on the alarm icon to open the notifications 
form. Enter the email address of the peson(s) who should receive notifications when an alarm occurs. Click the + 
button to add additional users and the Update button after all email addresses have been entered.

The map will show the locations of the selected ShockLog Satellite. Alarm and summary location pins will be 
clustered by proximity. Alarm pins will be displayed in red while summary pins will be displayed in blue. Pins 
displayed with a number in them can be clicked and the map will zoom in until you can see individual pins. A red 
heat map around the pins indicates that there is at least one alarm within that cluster. 



113

APPENDIX C - SPOTSEE PLATFORM

This document is written and published by ShockWatch, Inc. All rights reserved.

ALARMS/SUMMARIES

UNIT INFORMATION TABLE

 On the right side of the asset page is the list of alarms and summaries for 
the unit. The alarm shows the axis as well as the value recorded on the 
axis. Summaries show the total number of alarms reported. If the ShockLog 
Satellite is in an area where it cannot communicate with the satellites, 
then the summary alarm count will alert users that an alarm has not been 
transmitted to the cloud and that the ShockLog should be downloaded at  
the end of the journey for details regarding any missed alarms.  

It is possible to turn off summaries (or alarms) from the cloud view.  When 
doing so, summaries (or alarms) will be removed from the map and the list.  

The trip path is traced by default in the SpotSee cloud. If you do not wish to 
see the journey path, you may remove the Lines from the map.  

Click on the item at the bottom of the alarm list to turn parameters off or   
on. The parameter that has been turned off will change to a gray color.

Below the map, a snapshot of information regarding the ShockLog Satellite is displayed. The Alarm Count summarizes 
the number of alarms in the selected time range. The Time Since Last Message is a quick way to determine when the 
last communication from the ShockLog Satellite has been. From this time, you can determine if a device has been 
turned off or has a potential connectivity issue. 

It may be desirable to turn off summaries when loading large amounts of data as this will speed the load process.  
However, you will no longer see all of the trip segments on the map.
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ALARMS OVER TIME

IMPACT HISTOGRAM

A graph of impact alarms over time is displayed.  Each alarm is represented in the x, y, and/or z axis.

Below the Impacts over Time graph, you will find the Impact Histogram. This graph will show you how many impacts 
occurred over a certain impact threshold. The graph divides the impact values into bins. Each bar on the graph 
represents the number times an impact occurred over a certain threshold.   

In the example below, there was one impact 10G or less in the y-axis, two impacts of 10G or less in the z-axis and 
two impacts between 11 and 20G in the y-axis.

Hover the cursor over the bars in the Alarms over Time graph to see the individual impact values.
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OTHER PARAMETERS

CHANGE ASSET NAME

The ShockLog Satellite will also record temperature, humidity and tilt & roll. Each parameter will have a value over 
time graph associated with it.  

The graph below illustrates temperature over time. Hover the cursor over the points in the chart to see the individual 
temperature values.

Devices in the cloud can be given names that are meaningful to the user. The asset name appears in the top left 
portion of the screen. To change the name, click the pencil icon to open the Edit Asset form. Enter the desired asset 
name and click update.


